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1 Welcome to PROLIN Smart Client
Welcome to PROLIN Smart Client. PROLIN Smart Client is a robust, thoroughly tested client for your Service
Management System. Using PROLIN Smart Client you secure the investment you made in your Service Management
System and add modern flexibility, feel, and software quality you are used to from using Microsoft products.

PRO LIN Smart C lient 10

PROLIN Smart Client is built from the ground up. The basis is a new, very solid core. The PROLIN software
development process is based on testing. You can be assured that every line of code is thoroughly tested. PROLIN
Smart Client is created using the latest technology and the latest, most efficient software development methods.
With almost 20 years of software development experience, PROLIN provides you the very best in ITIL support
software.

PROLIN Smart Client enhances your Service Management System installation with a client that fits in a Microsoft
Office work environment. You can use the functionality you are used to in your favorite office application. The look
and feel of PROLIN Smart Client is close to Microsoft Office 2010.

PROLIN Smart Client is only the start of easy to use, powerful and flexible ITIL implementations.

1.1 State of the Art User Interface

The user interface of PROLIN Smart Client is very similar to the look and feel of Microsoft Office 2010. PROLIN
Smart Client will be familiar and actions you can take in the Microsoft Office user interface are applicable to PROLIN
Smart Client.
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The user interface components in PROLIN Smart Client are consistent throughout, giving each component a
recognizable look and feel.

1.1.1 Gadgets and Action Windows

The action windows will help you to structure your work in the UI. You can place the tools at a location in the
workspace of your choice. Have the tools available at the spot where you need them. The tools that make your
working life enjoyable will be made available as Smart Client gadgets. PROLIN, PROLIN's partners and third parties
are working to create the Smart Client gadgets that make ITIL even more easy.

Two currently available tools available in action windows are:

· The navigator that makes it easy to find the items used in processes.

· The attachment management window used in forms to manage attachments.

Smart Client gadgets are easy to read user interface components. Smart Client gadgets show information in a
colorful, compact or joyful way.

Currently, the following Smart Client gadgets are available:

Calendar

Clock

Smart Client gadgets are pluggable components and may be provided by PROLIN, PROLIN partners or third parties.
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1.2 Highest Quality

The PROLIN development team makes use of the latest methodologies to create PROLIN Smart Client. With test
driven development the PROLIN development team makes sure that every line of code is tested several times a day.
Every day new tests are added in order to test the code under different conditions. The tests are created before the
code is written. The code is then developed until the tests results indicate the software functions correctly. The
benefits of test driven development for you:

· Our developers are more productive. They have more time to add the functionality you want.

· Our developers create tests from the user's perspective. The resulting program is very close to the way you
work.

· Our developers know immediately when they do something wrong. Their mistakes will not find their way into the
end product you work with.

· The code is better structured, allowing more precise changes later. You can start using the software with
confidence immediately.

1.3 Accessibility

Consistent with the Microsoft Office 2010 look and feel, accessibility is supported in the following ways:

· Navigation through the keyboard

· Keyboard shortcuts

See Using Shortcut Keys
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2 Using the Smart Client
You will find that the PROLIN Smart Client is very easy to use and will improve your productivity. In this chapter

you will learn the basics of using PROLIN Smart Client. In the following chapters you will explore the PROLIN

Smart Client more in-depth. By going through this manual from time to time you will find that you can unlock even

more functionality than is apparent at first glance.

2.1 Starting the Smart Client

To start PROLIN Smart Client, do one of the following:

· Double click the PROLIN Smart Client icon on the desktop,

· or, in the Start menu point at PROLIN, Inc., then point at Service Management and choose PROLIN Smart
Client.

When you are starting PROLIN Smart Client for the first time, you need to setup your account first which can be
done by pressing the Create New Account... in the shown startup screen:
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In the Account Properties dialog you first indicate the type of connector your are using and the server name or
IP address of either PROLIN Power Server or Service Desk. To verify that you entered this information correctly,
press the Test Connection button:

 

The Transport option allows you to select a different form of communication between the client and the server.
This can only be a different value than itp if you are using the PROLIN Connector and if you are using PROLIN
Power Server 2016 or later.

By clicking on the Auto Configuration button PROLIN Smart Client will try all options and suggest the one that had
the best results for your specific location.

Depending on the selected connector you now need to specify the method for authentication you want to use. In
general, Basic authentication is supported by all connectors and requires you to enter a username and a
password. If you use the PROLIN Power Server connector can also make use of Integrated Windows
authentication which allows you to sign in using your Windows credentials. Note however that this type of
authentication requires that you have logged on to the Windows domain and that the server is configured properly. 

This is all you need to do to use PROLIN Smart Client. Your connection information will be stored locally in a safe
location. The next time you start PROLIN Smart Client, it will automatically use the saved information. The PROLIN
Smart Client console will now open.
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2.2 Using the Application Menu

Use the Application menu for many application wide functions and settings. The Application menu can be found
left of the Home tab in the ribbon. The following image shows the Application menu.

For an explanation of the commands, follow the hyperlinks below:

· New: Creating a New Item.

· Open: Opening An Item In A Form

· Print: Running Reports

· Print Preview: Changing The Layout Of A Report

· Administration: Administration Module

· Reports: Smart Reporting

· User Options: Changing User Options

· Exit: Closing The Smart Client

See also Parts Of The Console.
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2.3 Changing User Options

Depending on your authorization settings, you may be able to change and save your user options.

To change user options, choose User Options from the Application menu.

User options in the A pplication
menu

Make sure you exit the User Options dialog with OK to save the chosen user options.

2.3.1 Notification, Report and Refresh Settings

In the General Options screen of the User Options dialog, you can choose notification, report and refresh settings.

General settings av aialble in the User O ptions

Notification Settings

The following settings are available:

· Provide feedback with sound. If selected, feedback such as warnings and error messages will be
accompanied with a sound.

· Show flashing tray icon when items are assigned to my group. If selected, let Smart Client scan for
Service Today items that are assigned to your work group. At the moment an item is newly assigned to your
group, an icon in the system tray will draw your attention so you can take immediate action. This option is handy
when you have PROLIN Smart Client running, but are working on other items or using other applications.

· Send an e-mail when items are assigned to my group. If selected, let the server scan for Service Today
items that are assigned to your work group. At the moment an item is newly assigned to your group, an e-mail
message will be sent to you so you can take immediate action. This option maybe handy when you are away
from your desk and have immediate access to your e-mail.
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· Show flashing tray icon when items are assigned to me.  If selected, let Smart Client scan for Service
Today items that are assigned to you. At the moment an item is newly assigned to you, an icon in the system tray
will draw your attention so you can take immediate action. This option is handy when you have PROLIN Smart
Client running, but are working on other items or using other applications.

· Send an e-mail when items are assigned to me. If selected, let the server scan for Service Today items that
are assigned to your work group. At the moment an item is newly assigned to your group, an e-mail message
will be sent to you so you can take immediate action. This option maybe handy when you are away from your
desk and have immediate access to your e-mail.

· Send me an e-mail if I need to approve an item. If selected, let the server scan for Service Today items that
require your approval. At the moment an item is saved that requires your approval an e-mail message will be
sent to you so you can pay attention to the item. This option maybe handy when you are not always using PROLIN
Smart Client and have immediate access to your e-mail.

Report Settings

Select the location where reports are saved by clicking the browse button at the right most side of the Output
folder field. When you save a report, you can find it in the folder you select here.

Refresh Settings

Select Allow automatic refresh if you want to update a view regularly. For example, some customers use this
option on a large screen in the Service Desk room. However, notice that if you select a short interval in the
Refresh Interval field this option may cause a large amount of network traffic and significantly slow down PROLIN
Smart Client. Use this option with proper judgement.

2.3.2 Applications Settings

The Applications screen in the User Options dialog allows to set applications used in Smart Actions. These
settings are the local settings for application called for by Smart Actions. With proper local settings, Smart Actions
can be defined centrally and used everywhere.

Local options for applications in smart actions

To set the properties of an application, do the following:
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1. Select an application from the application list at the top.

2. Enter a name, command line and working directory in the Application Properties section at the bottom.

3. Click Test.

· Application name should be the same as used in the Smart Actions.

· The command line must only contain the name of the executable.

· The command line shall not contain parameters as these will be provided by the action.

· The command line may contain environment variables in the application's path.

2.3.3 Selecting the Time Zone, Language and Date
Format

The regional settings are concerned with formatting values in forms and views.

Time zone settings in Reginal screen

The language setting determines what language is used for labels, buttons, field names etc. If a choice is available,
it will be shown in the Language list. However, the language must be made available through translation and
distribution of files. Depending on your company, other languages than the standard English language are available.

To view the time values correctly in Views and Forms, you must set the time zone in which you work. Every date
and time value in PROLIN Smart Client is stored in Greenwich Mean Time (GMT) and shown to you in the time zone
you select in the user options. You can choose the correct time zone from the Primary time zone list.

The date and time formats make it easier to quickly read dates. Choose a format that you are most comfortable
with. What formats are available depends on the language of the operating system settings you use. For date
formatting in views, see Changing View Options.
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2.3.4 Adding and Editing Login Accounts

You find settings for your login accounts and password in the Security screen of the User Options dialog.

A first account will be made when you first start up PROLIN Smart Client. After the first login, you can add accounts
to login to alternative servers. PROLIN Smart Client will automatically adjust to the right service pack needed to log
on to the server used in the account.

User A ccounts

To add an account, click New.
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To edit account setting, select an account in the Accounts list and click Edit.

User A ccounts Dialog

The Transport option allows you to select a different form of communication between the client and the server.
This can only be a different value than itp if you are using the PROLIN Connector and if you are using PROLIN
Power Server 2016 or later.

By clicking on the Auto Configuration button PROLIN Smart Client will try all options and suggest the one that had
the best results for your specific location.

NOTE  With the Account Properties dialog you do not create an account on the server. Ask your system
administrator for the correct account information. Changing the password in the Account Properties dialog has
no use if the password is not known on the server. For correctly changing your password, see below.

To set an account to default, select an account in the Accounts list and click Set As Default. The default account
change will take effect the next time you start PROLIN Smart Client. If log on with the new account fails, there is no
option to change accounts and start up may then take longer. Make sure you change to an account that will work
the next time you start up. For example, test the connection first before you set the account as default. To test a
connection, select an account in the Accounts list and click Edit. In the Accounts Properties dialog, click Test
Connection.

To change the password of the currently active account, click Change Password and fill in the correct and new
information in the Change Password dialog. Using this function makes sure the password is updated on the
server.

The change password dialog



© 2024 PROLIN Inc.

PROLIN Smart Client 2020

Page 19

2.3.5 Search Settings

Even though PROLIN Smart Client is optimized for performance, still searches use a lot of resources and may have
considerable impact on how you appreciate performance. The search settings will have an impact how quickly
PROLIN Smart Client responds. Settings that may cause large search results will give you complete information.
Settings that may cause small search results will give you faster results. Choose your search settings wisely.

You find the following settings in the Search screen of the User Options dialog.

·Prompt when new search will clear current search criteria . PROLIN Smart Client optimizes searches by
reusing search criteria. If search criteria cannot be reused, you will notice a temporary reduction of performance
until optimizations are found again. A notification when search criteria are cleared, helps you make use of
optimizations by allowing you to choose different search criteria.

·Recently used searches . Recently used searches are used to find optimizations in searches. More searches
kept will result in better optimizations, but also in larger cache sizes.

Search settings in the User O ptions dialog

·Show warning when query restriction is exceeded . A query restriction may be set on your account by the
system administrator. The query restriction limits the amount of items returned in a search result. A low number
in the query restriction helps reduce network traffic and resource use, but may give the impression that PROLIN
Smart Client does not return all information needed. A warning if the query restriction is exceeded thus helps
validate the search result.

·Start Advanced Find when Quick Find exceeds query restriction . Query restrictions also apply to Quick
Finds. Large amounts of items in a Quick Find result are cumbersome to use. Using Advanced Find with Quick
Find will thus help you find the right choice quickly.

2.3.6 Changing Appearance

Changing the appearance of PROLIN Smart Client will attract better attention to the required fields.

A ppearance of a required field
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At the side of the label you will see a bar indicating the field is required, make sure these fields have a value. The
field may be required because ITIL processes make it required, or because your company's processes make it a
required field. Before you can save and close a form, all required fields must have a value. A field may become
required after giving another field a specific value. For example, if you set the Status field of a Service Call to a

Closed  value, the Closure code becomes required. With the Closure code you provide the reason why the Service
Call is closed. Sometimes required fields may be obscured for some reason, make them as clear for you as
possible.

C hoose color for the required field

To choose a better appealing color for required fields, open the Indicator color list. From the Indicator color
list, choose a color. In the Custom tab you can define your own color, or choose from the predefined colors. In the
Web tab you can choose a large number of predefined colors by name. In the System tab you can choose from
predefined system colors. The system colors are colors as they are used in forms and buttons of the operating
system.

The appearance settings are one of the many accessibility features in PROLIN Smart Client, see also:

· Required Fields

· Accessibility

· Using Shortcut Keys

Specify a theme to modify the look & feel of PROLIN Smart Client
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By choosing one of the themes you can modify the way the application looks like.

2.4 Closing the Smart Client

To close the console, do one of the following:

· Click the close window (cross) button in the upper right hand corner of the console.

· Click the Exit button.

A pplication Exit from the Q uick A ccess bar

· Choose Exit from the Application menu.

A pplication exit from the
application menu

· Press Alt + F4 on the keyboard.

· Press Alt, now different key options are shown.

· Press E to exit the Smart Client, or

· Press A to open the application menu. In the application menu press E to exit the Smart Client.
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2.5 When Starting the Client Fails

When starting PROLIN Smart Client fails, the following may help.

· The message "Access denied: incorrect name or password. Click Sign In to retry to log on" appears.
You entered the wrong user name or password. Find the correct user name and password and try again.

· The message "Failed to connect with server. Check that the application server is running." appears.
This problem may have the following causes:

1. You are trying to connect to a server where no Service Desk server is running. Contact the system
administrator to find the correct server.

2. You are trying to connect to the correct server, but the Service Desk server is not running. Contact the
system administrator to make sure the Service Desk is running.

3. You are trying to connect to the correct server, but have not provided the correct port number. Depending
on the configuration of the Service Desk server the standard or an alternative port number is chosen for
communication. If an alternative port number is chosen, the port number must be provided with the server
name. In the login screen enter the server name as follows:

· If the standard port is used, enter the server name or the IP address in the Server field.

· If an alternative port is used, enter the server name, followed by a colon, followed by the port number
(<server name>:<port number>) in the Server field.

4. You are trying to connect to the correct server with a running Service Desk server. In this case, a firewall
may prevent connection to the Service Desk server. Contact your system administrator to create an
exception for PROLIN Smart Client in your firewall.

2.6 Updating the Client

When there is a new version available of PROLIN Smart Client it can be downloaded via the website:
http://products.prolin.com.

A newer version can always be installed over the older version, there is no need to do an uninstall first.

2.7 Changing Supported Service Packs

When PROLIN Smart Client starts, the software checks the service pack of the Service Desk server. If the service
pack of the Service Desk server does not match any of the service pack support files already available on your
computer, the service pack configuration screen will appear at start up.

If you do not want to install extra Service Desk service pack support on the computer you work on:

· Click Back to return to the log on screen and choose a different server,

· Click Cancel to quit the PROLIN Smart Client start up.

Click Continue to download and install the required Service Desk service pack support files. After the service pack
support files are installed the log-on screen will be shown again. Enter the information and click Start.

http://products.prolin.com
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The Service Desk service pack support files are installed only once. Once the necessary service pack support files
are installed on the computer, PROLIN Smart Client will automatically detect the service pack of the server you
connect to and switch to the correct service pack support files.

If the Service Desk server has a service pack not currently supported by PROLIN Smart Client, then please contact
PROLIN or your PROLIN partner to request support for your particular service pack. If an unsupported service pack
is detected, a screen notifying the user appears.

2.8 Using the Client Behind a Firewall

PROLIN Smart Client needs network access to the Service Desk server. When your computer is protected by a
firewall, you must create an exception for PROLIN Smart Client or allow the use of Service Desk client
communication ports.

The PROLIN Smart Client application is found in the location that is given during installation and is called smc.exe
(default is C:\Program Files\PROLIN Smart Client\smc.exe). 

To learn how to create an exception in your firewall, read the documentation of your firewall. For example, to make
an exception for PROLIN Smart Client in the Windows firewall, do the following:

1. Log on to the computer as the administrator.

2. In the Start menu, click Control Panel.

3. Click Security Center and then click Windows Firewall.

4. In the Exceptions tab page of the Windows Firewall dialog, click Add Application.

5. In the Add Application dialog, click Browse.

6. In the Browse dialog, navigate to the PROLIN Smart Client executable as described above.

7. Select smc.exe  and click Open.

8. Select smc.exe  in the application list and click OK.

9. Close the firewall and the Control Panel.

Because the application is stored in the user folders of the computer, an exception must be created for every user
that uses PROLIN Smart Client on the same computer.

When you create an exception for the application, you do not need to create an exception for the ports used.
However, if you create and exception for the used ports you do not have to create an exception for PROLIN Smart
Client for each user.

2.9 Support

The installation website provides the updates of the software automatically. Updates of PROLIN Smart Client
software will be delivered regularly. See Updating The Client to learn how to update PROLIN Smart Client.

If you have comments, suggestions or requests. Contact your support group or send an e-mail message to
support@prolin.com
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2.10 Help Improve PROLIN Smart Client

The best way to help improve PROLIN Smart Client is to use it. PROLIN Smart Client will make your life easier at
work. However, there may be times when you encounter issues the development team would like to know more
about.

These kind of problems occur infrequently and so PROLIN would like your help.

If you want to make sure your information stays correct, make sure the Ignore the error and attempt to
continue option is not selected. This should only be needed if you started an operation that involves saving
information.

Please provide as much info as you can in the information field concerning the steps that led up to this error
message.

If you have no direct access to the internet, then click Save as File. You can then save the error report as a file
and send the file to support@prolin.com.

You can help improve PROLIN Smart Client by simply sending the problem report and click Send Error Report. 

Prov id y our email w ith the error report
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PROLIN would appreciate the opportunity to contact you about the error. If you want to be contacted by PROLIN,
then please provide your e-mail address. If you do not want to provide your e-mail address for any reason, select I
prefer to send this report anonymously. Click Send Error Report.

The message is sent

Thank you for your cooperation and we apologize for any inconvenience.
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3 Navigating the Smart Client
The amount of information you can access through PROLIN Smart Client may be overwhelming. In this chapter you
will learn how to find your way through the user interface. In the next chapter you will learn how to perform basic
tasks.

3.1 Parts of the Console

When you start PROLIN Smart Client the console is automatically shown. In PROLIN Smart Client you do your work
by analyzing, finding and updating information in items. The items may be Service Calls, Incidents, Problems and
many more. While working on the items in the console your work is part of the IT processes as they are defined in
your organization. PROLIN Smart Client helps you adhere to the defined processes and procedures. The console is
the starting point of your work.

The central part of the console is the view window. The view window contains a view showing items. Above the
view window you will find the ribbon and the application icon. The ribbon contains tabs and each tab contains
commands. There are two tabs in the ribbon. The Home tab contains general commands such as Print and
Advanced Find. The View tab contains commands to configure the view.

To the left, right and bottom of the view window you will find action windows. These action windows contain tools
you may regularly need while working with PROLIN Smart Client.
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The below image names the parts of the console.

Parts of the C onsole

Some parts of the console have a standard place:

· The view window will always be in the middle of the console.

· The scrolling action windows are always to the outside of the pinned action windows.

3.1.1 Checking the Connection

The lower right hand corner shows the status of the connection. PROLIN Smart Client may have to retrieve a large
amount of  information and thus may be working for some time. The lower right hand corner shows you what is
going on.

Lower right hand corner when working
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A moving green indicator shows that PROLIN Smart Client is working. Please wait.

Lower right hand corner if connection is lost

When the green indicator stopped and the connection indicator is red, then the connection is lost. PROLIN Smart
Client will try to reconnect to the server again. Once the connection is established, the connection indicator returns
to normal. The connection tool tip will show the user's name and the name of the server PROLIN Smart Client is
connected to.

Lower right hand corner when connection is
good

3.1.2 Counting Items in the View

The lower left hand corner shows how many items are shown in the view and how many items are selected.
PROLIN Smart Client may have to retrieve a large amount of information and thus may be working for some time.
The lower left hand corner shows you what is going on.

The lower left hand corner when
working

The text Working indicates that PROLIN Smart Client is searching for items. Please wait.

The lower left hand corner when
nothing is selected
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The search resulted in items. Now the lower left hand corner indicates the number of items shown in the view.
When the number of items in the view is larger than fit on in the view, scroll bars will be shown. The number of
items in the view will not exceed the query restriction set for your account.

The lower left hand corner w ith
twelv e items selected

When you select more than one item, the lower left hand corner will show the number of items you selected. The
selection may exceed the height of the view, still the lower left hand corner will conveniently show the number
selected.

3.2 Customizing the Console

You can customize the console in various ways. Do any of the following.

· Changing The MyTasks View

· Minimizing And Maximizing The Ribbon

· Moving Action Windows

· Customizing The Navigator

· Maximizing The Workspace

· Maximizing The Form

Customizations are saved upon closing the console.

3.2.1 Changing the MyTasks View

The MyTasks view is a great view to start your day. All items that are assigned to you or to your group, and all
approval tasks that you have are shown in one view. You may not have approval tasks or you may not be interested
in the items assigned to your group. So, you may want to change the MyTasks view.

To minimize, collapse, the
windows within the MyTasks view
click on the double V button in the
upper left hand corner of the
window you want to collapse.

My  Tasks collapsing and expanding

To resize the windows in the
MyTasks view, drag the splitter
until the window has the right
size.

Splitter
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3.2.2 Minimizing and Maximizing the Ribbon

In PROLIN Smart Client you will work with many items and may want to see as many items and details as possible.
To see as many details as possible, scroll up action windows and minimize the ribbon. For easy access to settings,
maximize the ribbon.

To minimize and maximize the ribbon do the following:

· To minimize the ribbon, press Ctrl-F1.

· To maximize the ribbon, press Ctrl-F1.

When minimized, the ribbon will use very little screen space. To use the commands in the ribbon, click on the
ribbon tab and then click the command. After using one of the commands in the ribbon, the ribbon will
automatically minimize again.

3.2.3 Moving Action Windows

Action windows can be moved around. Changing the location of action windows allows you to adjust the console (or
form) to your way of working.

To move an action window, do the following:

1. Point the mouse at the name of the action window, the window scrolls open.

2. Pin down the action window. While you move the mouse away, the window stays open.

3. Click and hold the title bar of the action window and drag the window to the location you want the window to
be. As you near the location where you can drop the window, location markers are shown.

4. Drop the action window on the location marker that indicates the location you want the window to be. When you
move the mouse over a location marker, the location where the window will be placed is indicated with a blue
shaded area.

5. Unpin the action window to allow the window to scroll.

Mov ing dockable w indow  w ith location markers
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When you drag the action windows around, location markers are shown on the console. These location markers
indicate locations where you may drop a window.

Markers for inside and outside locations

The inside markers indicate locations on the inside section of the console, for example on the outside of the action
window. The outside markers indicate locations on the outside of the console. When you move the action window
over an already docked window, the location markers relative to the docked window will appear. With moving
around and using the right location marker you can easily place the action windows exactly where you want them.

3.2.4 Customizing the Navigator

To customize the grouping in the Navigator, click Customize Groups at the top of the Navigator.

It is possible to choose how you want the Navigator to behave while you are changing views that you've opened in
several tabs. 

1. If the "Track Navigation" option is off, the Navigator remains in the position it was after adding the last view to
the tabbed views.

2. If the "Track Navigation" option is on, the Navigator will show the position in the navigation tree of the view that
is currently active.

Location of Track Nav igation Button
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3.2.5 Maximizing the Workspace

Every once in a while you may want to maximize your workspace. The columns in a table view cannot get wide
enough. You would like to see more of the navigation view in an Explorer view. Or, you look at a chart with small
details and you want to make a good print of the chart.

To enlarge your workspace, you can do the following:

· Close all action windows, if they are open. For opening and closing action windows, see Using Action Windows.

· Minimize the ribbon. To minimize the ribbon, click the Minimize Ribbon button at the far right hand of the ribbon
tabs.

· Maximize the window. To maximize the window, click the Maximize Window button in the upper right hand
corner of the window. Alternatively, press ALT+SPACE  on the keyboard to open the system menu and choose
Maximize. 

To maximize the workspace with one click, in the Workspace group in the Home tab, click Toggle Full Screen.
The Toggle Full Screen command closes pinned action windows, minimizes the ribbon and maximizes the
window.

Workspace group
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When the ribbon is minimized, the Minimize Ribbon button is replaced with the Maximize Ribbon button.

A  full screen w indow

To take the PROLIN Smart Client window out of full screen mode, click the Home tab label to open the Home tab
and then click Toggle Full Screen. Alternatively, click the Maximize Ribbon button and then click Toggle Full
Screen in the Home tab.

3.2.6 Maximizing the Form

In a form the fields in the main page or tab page may not be visible. However, you want to have as good an
overview as you can and still navigate from item to item in the form.

To maximize the space available for the form, do the following:

1. Open the form.

The F irst, Prev ious, Next and Last
commands

2. Minimize the ribbon. To minimize the ribbon, press Ctrl-F1. See also Minimizing And Maximizing The Ribbon.

3. Click the Maximize button in the upper right hand corner of the form, or press Alt + SPACE to open the form's
system menu and select Maximize.
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3.3 Using Action Windows

Action windows contain tools that you may need regularly while working with PROLIN Smart Client. While PROLIN
develops the PROLIN Smart Client, more tools that reside in action windows may become available. These tools
may be created by PROLIN, PROLIN partners or third party providers. Some tools are required for easily finding
information such as the Navigator , other tools may just make working more enjoyable. Depending on how you use
the tools, you may want to scroll the action window, pin it down or close the window.

To open or close a action window, click the button of the action window in the Workspace group on the Home
tab.

Alternatively, to open and close the action window, move the mouse over the name of the action window. The
window scrolls open. When you leave the action window and work on another part of the console or form, the
action window will close.

O pen dockable w indow

In case you often need the tool in a action window, you may want to have the action window open all the time. To
keep the action window open, open the window by moving the mouse over the name of the  action window and
click the pushpin button. A horizontal pushpin means the action windows scrolls open and close. A vertical pushpin
means the action window is pinned down.

Pushpin states

To remove a action window from the console or form, click the close window (cross) button in the window's upper
right hand corner. The standard action windows will stay in the view or form. You cannot remove the navigator,
calendar, clock and dashboard from the console nor can you remove the attachments window from the form.

3.4 Parts of a View

Views provide an overview of the items. The items may be Service Calls, Problems, Changes etc. Different views
are available:

· MyTasks view. The My Tasks view shows all tasks and items that are assigned to you.

· Service Today view. The Service Today view shows all items that can be assigned.

· Table view. The Table view shows items in a list.
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· Explorer view. The Explorer view provides for easy navigation through the records that may be shown in a table
view.

· Tree View. The Tree view shows items in a hierarchical tree structure.

· Chart view. The Chart view shows aggregated information in a picture.

· Configuration Item Structure view. The Configuration Item Structure view shows configuration items  and their
relations. Different layouts of the view can be used to visualize relations between CIs.

· Scheduler view. The scheduler view shows Projects, Changes and Work Orders in a project format.

See also: Finding And Opening A View

3.4.1 The My Tasks View

The My Tasks view shows all tasks and items that are assigned to you. The My Tasks view is a perfect starting
point of your day. See Working With My Tasks.

The MyTasks view has the following parts:

Parts of My Tasks V iew

3.4.2 The Service Today View

The Service Today view shows all items that can be assigned. The item types shown can be assigned to a Person
or a Workgroup, these items are Service Calls, Incidents, Problems, Changes and Work Orders.
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The Service Today view is either a table view or an explorer view that shows more than one item type. You will see
the Item Type column only in the Service Today view. The Item Type column shows you which type the item is.
When you open an item from the Service Today view, the system opens the item in a form appropriate for that
item. A Work Order will open in a Work Order form and an Incident will open in an Incident form. You can not
change the Item Type field of the items. See Working With Service Today.

Parts of Serv ice Today  V iew

3.4.3 The Table View

Table views show items in a list. You use table views to find items, and see the main information of the item. To
find and change details of the item, you open the item in a form. The table view is the common view used to open
items in forms. Table views can be part of other views such as the My Task View and the Explorer view. See
Filtering Items In A Table View.
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The table view has the following parts:

Parts of The Table V iew

3.4.4 The Explorer View

An explorer view provides for easy navigation through the records that may be shown in a table view or chart. In an
Explorer view you can navigate through items based on the values of different fields. The field value selected in the
navigation view filters the items in the base view. The items in the detail views are items that have a relation to the
item selected in the base view. See Finding Items In An Explorer View.
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The explorer view has the following parts:

Parts of The Explorer

3.4.5 The Tree View

A tree view shows items in a hierarchical tree structure. Just like a table view, the tree view shows details of
selected fields. The tree allows easy navigation of the items.

Tree views show information in a way that resembles a tree. In a tree there is a root and from this root grow one
or more branches. The branches may have smaller branches and so on. If we take an organization as an example,
the root may be the company. The company at the root may branch out in divisions. The divisions may branch out
in regions, The regions may branch out in departments. Of course, how a company is structured depends on the
organizational style of the company. Each entry in a tree is called a node. In the example, the company is the root
node and the departments are the end nodes. End nodes do not have further branches.

See also Navigating Trees.
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The following figure shows an example Tree view.

Example of an organization structure in a Tree v iew

3.4.6 The Chart View

A chart view shows aggregated information in a picture. Charts are an easy way to get an overview. The 3D chart
is ideal for inclusion in presentations. See Running Reports, to make a report in an image file format. The chart is
then ready for use in a presentation. Use the 2D chart in information analysis tasks, see Drilling Down In A Chart.

There are various types of charts available.

Example of A  C hart V iew

3.4.7 The Network View

A network view is a graphical representation of connected configuration items. The network follows the parent-child
relations of the Configuration Item. That means that the elements in the network view may or may not follow a
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physical network such as an IP network. The relations between Configuration Items may be created to find
important relations, for example the relation between installed software and the operating system version it is
installed on. Other relations may be created to quickly assess the impact of Changes. What the network view shows
depends on the kind of relations your organization puts into the Parent-Child relations of the Configuration Items.

The items in a network view are connected with arrows. The arrow originates from the parent and points to the
child in the Parent-Child relation.

3.4.8 The Scheduler View

A scheduler view shows Projects, Changes and Work Orders in a project format. You can find items in a Project or
Change quickly by scrolling through the timeline or clicking the search buttons. The Scheduler view shows multiple
projects in one view. Double clicking a planned item opens the item in a form.
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The Scheduler view has the following parts.

Parts of The Scheduler V iew

3.5 Navigating Trees

The Navigator, the Explorer views and Tree views contain trees. You can navigate all trees in PROLIN Smart Client
the same way. Use one of three basic methods:

· Using The Mouse

· Using The Keyboard

· Typing Letters

Names used in trees

Using The Mouse

To expand or collapse branches select an item name and do one of the following.

· Click on the plus sign to expand the branch.

· Click on the minus sign to collapse the branch.
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Using The Keyboard

· Press Numeric Key + to expand the current selection.

· Press Numeric Key - to collapse the current selection.

· Press RIGHT ARROW to expand the current selection if it is not expanded, otherwise select the first child.

· Press LEFT ARROW to collapse the current selection if it is not collapsed, otherwise select the parent.

· Press DOWN ARROW to select the next line in the tree.

· Press UP ARROW to select the previous line in the tree.

Typing Letters

If you know the name of an item you are looking for you can navigate a tree using the alphanumerical keys on your
keyboard. Do the following:

1. Select an item in the tree.

2. Type the first letter of a name, the first item name in the tree with the typed first letter will be selected. If that
view is in a collapsed item, the item will be expanded.

3. Type the second letter, the first item in the tree with a name beginning with the two typed letters will be
selected.

4. Continue typing until you find the right item.

Q uick F ilter results as y ou ty pe in the Nav igator

You can continue typing with any speed, even wait. To begin a new sequence, press Esc, select a node with the
mouse or select anything outside the tree view.

In the Navigator, the tree is filtered as you type. A balloon showing the filter and the number of matching views is
shown. Matching views names will remain in the navigator. Only the navigator tree has a filter and shows the
number of matching items in a balloon.

See also Using Shortcut Keys.

3.6 Parts of a Form

The forms have the same parts as the console. Although console and forms contain the same parts, console and
forms serve different purposes. The console presents multiple items in a view, a form presents the details of an
individual item in pages. You open the form from a view.
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The central part of the form consists of the main page and the tab pages. Left, right and to the bottom of the
pages, you will find action windows. The form has two special action windows.

· In the Attachment window you can manage attachments of an item.

· The results of the View Action commands are shown in action windows.

The following image shows the parts of a form.

The Parts of a Form

See also:

· Opening An Item In A Form

· Opening Views Related To A Form

· Managing Attachments In A Form

3.7 Shortcut keys

Next to the standard Windows shortcut keys PROLIN Smart Client has a few specific shortcut keys available as well.

The table below gives an overview of these keys. Whether or not a shortcut key works depends on where you are
(i.e. Ctrl-S works in a Form but not in a View).

Console

F1 Help

F2 Advanced find

F5 Refresh
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F11 Window full screen

Alt-F4 Application exit

Ctrl-F4 Close open item(s)

Ctrl-D Delete selected item(s)

Ctrl-F Quick search in view data

Ctrl-M Open selected item(s)

Ctrl-N New item

Ctrl-O Open Item dialog

Ctrl-P Print

Data Form + Email Data Form

F2 Advanced Find

F5 Refresh

F7 Spellcheck

Alt-S Save and Close

Data Form 

Ctrl-F4 Close

Ctrl-D Delete

Ctrl-N New

Ctrl-O Open Item dialog

Ctrl-P Print

Ctrl-S Save

Email Data Form

Ctrl-R Reply

Ctrl-S Send

Ctrl-Shift-F Forward

Ctrl-Shift-R Reply all

Attachment Pane
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Del Delete

Ctrl-Add(+) Add attachment

Collection Editor

Del Remove item/remove relation

Advanced Find

F2 Search/Find now

F11 Window full screen

Ctrl-D Delete selected items

Ctrl-N Create new filter

Ctrl-O Open filter

Ctrl-P Print

Ctrl-S Save filter

Expression List (filter advanced tab)

Ctrl-Add(+) Add expression

Ctrl-Subtract(-) Remove expression

Forms Designer

F11 Window full screen

Del Remove element

Ctrl-F4 Close form

Ctrl-E Form properties

Ctrl-R Rename element

Ctrl-S Save form

Ctrl-Left Move page left

Ctrl-Right Move page right

Ctrl-Up Move element up

Ctrl-Down Move element down

Ctrl-Shift-D Remove Page
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Ctrl-Shift-P Add page

Ctrl-Shift-R Rename page
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4 Using Views
Let's get to work. In this chapter you will learn how to perform basic tasks with PROLIN Smart Client. Refer to
Navigating The Smart Client to learn the parts of PROLIN Smart Client and what their names are.

4.1 Finding Information

PROLIN Smart Client makes finding information easier than ever. PROLIN Smart Client has smart functionality that
help you find the detail quick and easy.

Basic to finding any information in PROLIN Smart Client is knowing that you work with the most sophisticated ITIL
compliant  Service Management software available. ITIL is all about good or best practices. Best practices result in
activities and tasks, coming forth out of processes and procedures, that provide the best results. Eventually you
perform the activities to achieve the objectives of the processes.

In PROLIN Smart Client processes and procedures are designed around items. For example, Problem Management
is a process around Service Calls, Incidents, Problems, Changes, and Services. In Problem Management you will
analyze all these items to identify possible Problems. Once identified and created in PROLIN Smart Client, you can
resolve the Problem.

In the next sections three examples of finding information are discussed. The discussions are brief. In the
discussions you will find links to pages where you can learn details of a certain task. In the first two examples
Problems are used, however you can perform the shown tasks on other items too.

The following examples are discussed here:

· Finding Problems, an example of finding information by analyzing items

· Closing a Solved Problem, an example of finding detail information of an item

· Finding a Colleague, an example of finding any information using advanced find

Finding Problems

Amongst other responsibilities, Problem Managers are responsible for identifying Problems. For example, Problems
can be identified by analyzing Incidents that come in over a given period, an hour, a day or a week. If in a given
hour the number of Incidents reported from network configuration items increased dramatically, then there might
be a problem. Often the network management system will automatically react to most events, but problems may
arise.

You can take two steps to identify Problems:

1. Manipulate a table view. Table views show all records and are thus the ideal starting point for a search.

· Find the view that contains the right information. See Finding And Opening A View.

· Filter the information that you see in the view. See Filtering Items In A Table View

· Show or hide columns to look at the information from various perspectives. See Manipulating Columns In A
Table View.

· Group items to focus on one group of items with shared field values. Within the group of items you can see
what further they have in common or how they are different. See Grouping Records In A Table View.
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2. Create a chart. Chart views show aggregated records and are thus ideal for showing trends in the records.

· Standardize analysis with drilling from a chart to another view. See Drilling Down In A Chart.

· Use charts to regularly create a report of a Problem. See Running Reports.

Closing A Solved Problem

Apart from identifying Problems, the Problem Managers are also responsible for the life cycle of the Problem.
Problem Managers identify and record Problems, and they make sure that Incidents do not occur anymore. To
change the details of an item, you may do the following:

1. Find And Open A View.

2. Open The Item In A Form.

3. With the form open, you may change the field values and save the result. To close a Problem, change the status
code.

Finding A Colleague

While there are more specific organizational networking tools, PROLIN Smart Client contains all the information for
your work related network. Whether it is to drink coffee or to discuss a Problem, all information about your
colleagues is available.

To find a Person you can either use a table view of the Person item of the Organization item group or you can use
Advanced Find. See Using Advanced Find to learn more.

4.2 Finding and Opening a View

To find and open a view, you use the navigator. The navigator is a action window, usually located to the left hand
side of the console. The navigator shows groups of items. For each item the available views are shown. The items
are shown in a tree and the views are shown in the branches under each item.

You easily navigate through a large number of views with the navigator's quick filter. 

Using The Mouse

To navigate to and open a view do the following:

1. Open the navigator, the navigator is usually open on the left hand side of the console.

2. At the top of the navigator select an item group. You can choose from the item groups that you are authorized
for.

Select Item group Serv ice
Desk

3. In the navigator tree, open an item branch. You can choose from the items you are authorized for.
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4. In the item branch, select the view.

Select v iew  A ll Problems

5. The view opens in the view window.

Alternatively, do the following:

1. Click All Views in the Manage group on the View tab.

2. In the All Views dialog, select the item type you want to see from the Item list on the right hand side.

3. In the Views list, select a view and click Apply View.

4. When you have found the right view, close the All Views dialog.

Using The Keyboard

You can quickly find and open a view if you know the name of the view.

The navigator contains a tree. The root of the navigator tree is a process and the smallest branches in the
navigator are views. The navigator may contain a large number of views. To more easily find the view you need,
the views are organized by item. Each item has views in branches. You can collapse and expand branches to
temporarily hide views and get a good overview. If an item has views in its branches, then there is a plus or minus
sign left to the item name. See Navigating Trees.

4.3 Changing View Options

Most views you will work with will be the same views as your colleagues use. The same views are used for the
same kinds of tasks. During your work you may find that changing a view slightly will give you a better look on the
details or will result in a better report you need for a meeting. Instead of creating a new view, you decide to alter
the view. Creating a new view is needed when a new task arises that is better supported with a new way of looking
at the items.

To change the layout of the view, do the following:

1. Open the view you want to change.

2. Open the View tab. The groups and icons available in the View tab depend on the view type that is opened.

3. In the View tab click Current View.

C urrent V iew  command for a table
v iew
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4. The View Options dialog is now shown.

V iew  O ptions dialog for a Table v iew

5. Change the settings in the View Options dialog box.

You can change some of the more common options of the view by using the commands in the View tab of the
ribbon.

Fields

Depending on the type of view, you can choose the fields the view shows. In a table view you can choose which
fields are shown in the columns. In a chart view you can choose the fields which are used to create the chart.

To select the fields in a table view, open the Fields screen. In the Fields screen, one list shows the available fields
and the other list shows the fields used in the table view. To show a field as column in the table view, select the
field in the available fields list and click Add or double click the field name. To select a field from related items,
choose the related item from the Show available field for list. To choose a display format for each field, first
open the formatting screen then select the field and choose the formatting options.

To select the fields in a chart view, open the Fields screen. In the Fields screen select fields for the X-Axis, the Y-
axis and for the series. Not all chart types show all these fields.

Filters

Part of the view definition of a table view and chart view is a filter definition. A view's filter determines which items
are shown in the view. Using a filter you can create a view that only shows Service Calls that are assigned to you.
See Editing Filters to learn more about advanced filters.

Format Rules

Format rules allow you to attract your attention to specific items in the list. In a view that shows all Service Calls,
you could highlight Service Calls that are past their deadline with a red font.

To create a new format rule, do the following:

1. In the View Options dialog, open the FormatRules screen.

2. In the Rules screen, click Add. In the Name dialog change the name and click OK.
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3. In the Rules Properties, select one or more character formatting settings. The Sample field will show what
the result is of the selected settings.

V iew  format rule properties

4. Open the Condition list and create one or more conditions. The rule condition determines to which items the
selected formatting will apply. The conditions are created like filters, for more information about how to create
filters see Editing Filters. The Condition list can be resized if needed.

5. When you have completed the condition, click the check mark button to save the condition.

4.4 Creating Personal Views

The views that are available when you start PROLIN Smart Client are the views made available for the processes in
your company. You may have the privilege to create your own personal views. Personal views are stored locally and
you can change them to make uncommon tasks easier.

Example of V iew  ribbon

To create a personal view, do the following:

1. Click All Views in the Manage group of the View tab.

2. In the All Views dialog, click New.

3. In the New View dialog, enter a name for the view and choose the type of view you want to create.

4. In the View Options dialog, set the view. See Changing View Options.
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5. When ready, click OK.

Personal v iew  toolbar

NOTE : The newly created and save personal view will be available in the Navigator with all selected fields when you
restart PROLIN Smart Client.

In the All Views dialog you can also do the following:

· Click Edit to open the View Options dialog. See Changing View Options.

· Click Delete to delete the currently selected view. You can only delete personal views.

· Click Copy to copy the currently selected view. A dialog will appear in which you can enter a name for the copy.

· Click Rename to rename the currently selected view.

· Click Reset to return a system view to the original settings, as received from the server. You cannot reset
changes to a personal view.

· Click Export the save the view configuration of the currently selected view to a file. You can distribute the file to
other users.

· Click Import to open a view configuration file.

4.5 Opening and Switching Multiple Views

To open multiple views, hold the Ctrl key while opening the view.

· Hold the Ctrl key while clicking on the view's name.

· Hold the Ctrl key while pressing Enter when selecting the view by name.

When you open views while holding the Ctrl key, each consecutive window is opened in its own tab page. If only
one view is open, there are no tabs visible.

To switch views, click on the tab of a view.
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To close views, click the close button (cross) button shown on each tab. Note that the tabs will not be visible for the
last open view.

4.6 Exporting View Data

Views give you a good overview for use in reports or presentations. You can export table views and chart views to
file. The exported file you can use in reports and presentations.

PROLIN Smart Client has many formats available for export. You can export to PDF which is a good format for a
document you want to distribute electronically. Picture files such as JPG or PNG files are good formats to use in
reports or presentations.

To export a view, do the following:

1. Open the table view or chart view.

2. Click Export in the Home tab of the ribbon:

C hoose the format from the menu

3. Choose the format you want from the Export menu.

4. Depending on the file type, a dialog will appear in which you can determine specific settings for the export
format.

5. Find a location and enter a name for the document in the Save As dialog, and click Save.

Some file formats, will use a picture of the view. For example, a PDF will use a picture of a chart. The view's picture
may not fit the page in the exported document. If you change the size of the view by changing the layout of the
console, you may find a better fit of the view in the exported document.

4.7 Table Views

Table views represent your data in a tabular format and provide a number of features for formatting, grouping,
sorting and filtering.
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4.7.1 Finding Items

The list of items in a table view may be long. Do not forget the scroll bar to scroll through the information.

To open an item in a form, double click on the item line in the view.

Item line, ready  to open the form

For working with a table view see

· Manipulating Columns In A Table View

· Grouping Records In A Table View

· Filtering Items In A Table View

4.7.2 Filtering Items

Filtering items in a table view is a quick way to zoom in on similar items. A filter can be set in the definition of the
view. In addition to the definition of the view you can create filters on the view yourself.

Creating filters on date fields works slightly different than creating filters on other fields, see Creating Date Field
Filters in this section.

Creating a filter on a column

To create a filter on a column do the following:

1. Move the mouse over the column header that you want to filter. Move until the filter button appears, the filter
button is normally hidden at the upper right corner of the column header. The filter icon resembles a funnel.

2. Click the filter button.

3. From the filter menu, choose a filter setting.

C olumn F ilter drop down menu

4. The filter button is now shown in the column header and a filter setting box is shown below the table view.
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Creating a Custom Filter

To start a custom filter, open the filter menu and click Custom. Now the Custom AutoFilter dialog is shown. In the
Custom AutoFilter dialog you can create a flexible filter based on the column you selected to create the custom
filter.

C ustom F ilter dialog

You can adjust the filter as follows.

1. Choose a filter that comes close to your needs.

2. In the filter settings box at the bottom of the table view, click Edit Filter.

3. The Filter Editor window appears. See Editing Filters

Creating Auto Filters

Auto filters allow you to quickly create and change filters. You create the auto filter in the view and the results are
shown immediately. However, Custom Filter give greater flexibility. To create an Auto Filter, do the following:

1. In the view, right click on any column header. From the context menu, choose Show Auto Filter Row.
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2. The view now shows the Auto Filter row below the header row of the view and the current edit settings below
the view.

V iew  w ith A uto F ilter row

3. Start typing text or numbers in the column that you want to filter. You can type text in multiple columns. The
column will be filtered using the Like  predicate. The view will show items that have the typed text somewhere in
the given column.

4. To close the Auto Filter row, right click in the header row and choose Hide Auto Filter Row from the context
menu.

Creating Date Field Filters

To create a filter on a date field column do the following:

1. Open the filter menu of the date field column.

2. Select Show All, Specific Date or Prior to this year

· Show All removes any existing filter.

· Prior to this year shows all items that have a date that is before January 1st of the current year.

· Specific Date allows to choose a date or a range of dates. See Date Selections below.

3. Click the close window (cross) button at the bottom left hand corner of the filter menu.

Date Selections

In the date field filter menu do one of the following.

· Click on one date to select that date.

· Zoom out: click on the month, year line to zoom out to months of a year, the years in a decennium and the
decennia in a century.

· Zoom in: click on a decennium, a year and a month to zoom to a specific date.
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4.7.3 Grouping Items

Grouping items is a great way to quickly gain overview. Sorting a column does group items with the same value
together. However, you can only sort one column at a time. Grouping brings items together and then you can still
sort the items on one of the other fields. You will quickly see resemblance and differences among the items in your
view.

Because you can collapse the groups, grouping helps navigating a table view. Collapse the groups and find the
group you are looking for, then expand that group to see the items available in that group.

To group items do the following:

1. Open the table view.

2. In the View tab, click the Group By command in the Grouping and Sorting group.

3. The Group By command is now highlighted and above the table view the Group By Box is opened.

Group By  command highlighted

4. Drag the column header you want to use for grouping to the Group By Box and drop the column header.

Dragging the first column to the Group By  box

Note that columns used for grouping can be filtered too. See Filtering Items In A Table View

Free Text Fields

Free text fields, such as descriptions, are not a good choice for grouping. Almost every free text field is different
and thus when you group by a free text field each group will contain only one item.
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Date Fields

Grouping on date fields will group items for each day on the calendar. To change the interval of the grouping, right
click on the column header in the Group By box, point at Group Interval and choose the interval.

Grouped by  Status and P lanned Fnish
date

Interval Result

None Items are grouped by difference of the date, result is equal to
the Day interval.

Day Items are grouped for each day of the calendar.

Month Items are grouped for each month of the calendar.

Year Items are grouped for each year of the calendar.

Smart The grouping will be automatically chosen for optimal clarity.
Groups will be shown as applicable.

· For dates in the past, items will be grouped in the groups
Yesterday, Last Week, Two Weeks Ago, Three Weeks Ago,
Last Month.

· The Older group is for items with a date older than last
Month.

· For dates in the future items will be group in groups
Today, Tomorrow, Sunday, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday, Next Week, Two Weeks Away,
Three Weeks Away, Next Month.

· The Beyond Next Month group is for items with a date
farther away than next month.

4.7.4 Manipulating Columns

Table views are used to give an overview of a list of items and they are used to open items in a form. To see a
field better on print, you may want to make more space for that field by removing another field. For example, to
show the complete description you remove the status code. In other situations, you may want to increase the width
of the status code and reduce the width of the description field. Either way, you increase the space available for
one of the columns in the table view.

To increase the space available for a field shown in a table view, you can either remove columns temporarily or
change the width of the columns.
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Temporarily Removing Columns

To temporarily remove a column in a table view, right click on the header of the column you want to remove.
Choose Remove This Column from the context menu.

Remov e the Information column

The column you remove this way will not be removed from the definition of the table view. To see which columns
of the table view definition are not currently shown, right click on a column header. Choose Column Chooser from
the context menu. The column chooser is not a action window.

To place the column you removed back into the table view, do the following:

1. Right click on a column header.

2. Choose Column Chooser from the context menu.

Information column in the
C olumn C hooser

3. Drag the column you want to place back from the Column Chooser window into the table view.

4. The column is back in the table view.

The removed column will stay in the Column Chooser until you replace the column or change the view options.

Changing The Width Of A Column

To change the width of a column, do the following:

1. Move your mouse over the side of the column header until a double arrow appears.

2. When the double headed arrow appears, click and drag the column border.

3. Release the mouse button when the column has the right size.

The changes of the width are not stored. The next time you open the view, the width of the columns will be
automatically adjusted.



Page 60 © 2024 PROLIN Inc.

PROLIN Smart Client 2020

4.7.5 Copying Information

To copy information from an item in a table view, do the following:

1. In the table view, select one or more items.

2. From the Edit group in the Home tab, click copy. Alternatively press CTRL+C  on the keyboard.

The Edit Group

3. You have now copied the information from the items to the clipboard. You have copied the information from the
visible columns of the selected items. This includes information from very narrow columns that are hardly visible
on the screen.

4. Switch to an application or a field where you want to paste the information. Place the cursor and press
CTRL+V  on the keyboard, or use the paste facilities of the application.

NOTE : Using Paste in a view will open the form of a new item in which you can paste the copied information.

4.7.6 Calculating

Imagine a customer wants to know the average Planned Cost of planned Changes. You can export a filtered table
view of the requested Changes to a spreadsheet, see printing and exporting Views.

To give the quick answer however, right click in the bar at the bottom of a column in the table view. From the table
view function menu, choose a function. The result of the function will be displayed in the bar at the bottom of the
column. The type of value in the table column determines what functions are available in the table view function
menu.

C hoose from the table v iew  function menu
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4.8 Explorer Views

Explorer views provide quick paths to items. For a Service Desk agent an explorer view may give quick access to
Service Calls created for people from a particular organization.

4.8.1 Finding Items in an Explorer View

In an explorer view you will find three parts. The navigation view, the base view and the detail views. What you
select in the navigation view filters the items in the base view. The information in the detail views are items related
to the item selected in the base view.

In the navigation view items may be shown as a tree or as a table. The trees are created from fields that refer to
an item with a hierarchy, for example Organization fields, or from codes that have hierarchy, for example Category
codes. The tables allow to show details of the item you use for navigating.

To be effective, explorer views take some time to plan and create. The item you are looking for may be in the detail
view. But, the explorer view is grouped with the views of the item in the base view. For example, to find the Service
Calls of a colleague of the caller you may use an explorer view that navigates on the organization, has Persons in
the base views and Service Calls registered for this Person in the detail views. Although you are looking for Service
Calls, you would find this explorer view in the Persons item branch in the Organization item group of the navigator
because the base view shows Person items.

The navigation view may be a table view or a tree view. To use the navigation view, do one of the following:

· See Navigating Trees to learn how to use trees.

· See Finding Items In A Table View to learn how to use a table view.

4.9 Chart Views

A chart view allows you to create an aggregated representation of your data.

The P ie chart Serv ice C all by  C ategory  in 2D mode
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4.9.1 Drilling Down in a Chart

Drilling down a chart only works in 2D mode of the chart. To switch from 3D to 2D, click the 3D/2D command in
the View tab of the chart.

C hart in 3D mode

Some charts have a Drilldown View defined in the chart definition. The drilldown view allows to move from a
chart to another view by double clicking a series or value element in a chart. The new view then shows details of
the previous view in a table or another chart view. For example, in the pie chart Service Calls by Category when
you double click the RFI category you may get a table view with all Service Calls of the RFI category. The All
Service Calls table view will be filtered with the same filter as the pie chart with an additional filter on the Category
you double clicked. If you link several charts this way, you experience drilling for information. Creating a useful
drilling experience requires planning and design. The links selected between the chart and the view should be
created to support a specific analysis task. Also, longer drilling chains do not necessarily provide more useful
information.

To add a drill-down view to a chart do the following:

1. Click the Current View command in the View tab.

2. In the View Options dialog, open the General page.

3. In the Drilldown View field select an appropriate view.

4. Clear the 3D checkbox.

5. Click OK.

To drill in a chart, double click on the display element of the chart. For example, double click a bar in a bar chart or
a section in the pie chart. Moving the mouse over the display element of the chart will highlight that display
element.

4.9.2 Changing a Chart

In PROLIN Smart Client most commands to change the appearance of a chart can be found in the View tab of the
chart. The appearance options allow you to quickly find a professional look for your chart and to print the chart. You
will be able to select an appropriate type of chart to represent the information.

V iew  ribbon for a C hart v iew

To change the general definition of the chart see Changing View Options. Part of the definition of a chart view is the
combination of values you choose for the X and Y axis and for creating series. How these values are displayed
depends on the type of chart you choose.
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To change the type of chart, choose the type of chart in the Chart group of the View tab.

C hoosing a
pie chart

When the chart is displayed in 3D, you can change the display angle of the chart. When you move the mouse over
the 3D chart, the cursor will turn into a flat hand. Click on the chart and drag the chart around, the cursor will turn
into a grabbing hand. In 3D mode, the 3D/2D button is highlighted.

Highlighted 3D/2D
button

If the chart is displayed in 2D you may be able to drill down to the information contained in the chart. When the
chart is 2D mode, the 3D/2D button is not highlighted.

See also Drilling Down In A Chart.

The P ie chart Serv ice C all by  C ategory  in 3D mode
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4.10 Scheduler Views

The scheduler view is a powerful view in PROLIN Smart Client which is available for all entities. 

A scheduler view can be made by choosing New in the All Views dialog. Added to the standard view types you can
now also select type "Scheduler". If you've chosen that type there are three dialogs where you can modify the view
to your specific needs:

1. General

2. Fields

3. Filter

General

In this dialog you can specify the following:

Schedule Title Define the title of the view.

Schedule Type Define the default display mode of the view. This can be changed when the view is
shown.
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Show empty resources All records that don't have a value in the field defined as resource property are grouped
together under an empty resource. If this option is not selected, records with no value
in the resource property field are not shown.

Show resource selector When checked the resource selector is shown

Show resources vertically If checked the value of the resource display property is shown vertically. Otherwise it is
shown horizontally.

Fields

In this dialog you can specify the following:

Start date The start date and time of the activity.

End date The end date and time of the activity.

Subject property The value which is shown in the view for the activity.

Description property The value which is shown as more information in the tool tip when hovering over the
activity.
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Resource property The value for which activities are shown. Activities are grouped by the Resource
property.

Resource display property The value which is shown for the resource in the view.

Filter

This is the standard filter dialog where selection criteria can be defined for this view.

Example

In the screens in the example below a schedule view is used that shows how Changes within a Project relate to
each other visually. The schedules can be shown in various calendar forms and in a timeline. You can easily switch
between the display modes.

Scheduler v iew  display  modes

In the four calendar modes, the Changes are shown on a calendar. In these modes all Changes of selected projects
are shown as they relate to each other on the calendar. 

Scheduler V iew  shows changes on a month calendar
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In this time line, the scheduler view for Projects shows Changes related to a Project within a lane for that Project. 

Scheduler shows projects in time lines

The time line view opens in the week that contains the current day. If a project lane shows no items, a quick
navigation tab appears in the time line. The quick navigation tab can navigate back in time or forward in time. Click
the quick navigation tab to jump to the start of the first next item in that direction.

Q uick Nagiv ation tabs in the time lines

4.11 Dashboard Views

Using dashboard views in PROLIN Smart Client end users can create composite views containing other view types
like tables, charts, cards, trees, and the new gauge views. The only restriction is that you cannot use other types of
composite views (like other dashboard views or explorer views). Note that a dashboard view is not bound to a
particular entity and can embed views that are entity-bound. 
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By default PROLIN Smart Client is shipped with the My Tasks dashboard view as shown below. In previous
releases this view was already provided but end users were not allowed to change its layout or content. Note that it
now also shows two gauge views at the bottom right. Also note that it appears below the My Dashboards node in
the navigator on the left hand side. If you create other dashboard views then they will also be shown there.

Dashboard show ing 5 child v iews

You can rearrange the layout of a dashboard by dragging and holding the header of a child view and dropping it at
your location of choice. Similarly you can increase or decrease the size of a view by using the drag bars between
the individual views.

To close a child view simply click the close button (cross) in the top right corner of its header. Note that no
confirmation will be asked, so if you close a child view by mistake you can re-add it by using the Views section in
configuration dialog of the dashboard view as described in the next topic.

Configuration
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The dashboard v iew  configuration dialog

In the shown dialog you can perform the following tasks:

· Add a new or existing view to your dashboard view

· Remove a view from your dashboard view

· Edit the configuration of a referenced view.

Adding Views to a Dashboard View

To add a new view, do the following:

1. Click the Add View menu item.

2. Click the New View... menu item.
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The New  V iew  dialog

3. In the New View dialog fill in an Item type, Name and View type

4. After pressing the OK button another configuration dialog will be shown for your new view.

5. Once you have configured your new view and pressed the OK button, it will be shown in the list of views in the
configuration dialog of the dashboard view.

To add an existing view, do the following:

1. Click the Add View menu item.

2. Click the Find... menu item to open the Find View dialog and search for an existing view:
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The F ind V iew  dialog

3. After clicking the Accept button, the selected view will be shown in the list of views in the configuration dialog
of the dashboard view.

 

 

4.11.1 Add or Remove Dashboard Views

Add Dashboard Views

While the default My Tasks dashboard view can be fully re-configured to your needs, it is also possible to add your
own custom dashboard views by doing the following:

1. On the console ribbon activate the View tab and then click All Views in the Manage section. As an alternative,
you can also right-mouse-click on the My Dashboards node in the Navigator and choose the Manage All
Views menu item instead.
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2. In the All Views dialog make sure that the item type in the top right corner is set to the (My Dashboards)
option:

The A ll V iews dialog show ing dashboards

3. Click on the New button in the toolbar to create a new dashboard view:

The New  V iew  dialog for creating a new  dashboard v iew

4. Press the OK button to show the configuration dialog for dashboard views.
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5. After.you have configured your dashboard view and pressed the OK button your newly added view will be
shown in the navigator underneath the My Dashboards node and also in the All Views dialog.

Remove Dashboard Views

NOTE: You cannot remove the My Tasks dashboard view.

To remove a dashboard view do the following:

1. On the console ribbon activate the View tab and then click All Views in the Manage section. As an alternative,
you can also right-mouse-click on the My Dashboards node in the Navigator and choose the Manage All
Views menu item instead.

2. In the All Views dialog make sure that the item type in the top right corner is set to the (My Dashboards)
option.

3. Select the dashboard view that you want to remove.

4. Click the Delete button in the toolbar.

4.12 Gauge Views

A gauge view allows you to create an aggregated measurement on a certain item type in your system. For
example, you can count the number of service calls that are assigned to you or to your workgroup:

Unlike other types of views (like table, chart, explorer, etc), gauge views are not standalone views and can only be
part of a dashboard view and therefore will not be shown in the navigation pane. 
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NOTE: In the current release a gauge are only capable to COUNT information in your system. In a future release
this will be extended with other aggregated functions like AVERAGE, SUM, MAX and MIN.

Add or Modify a Gauge View

Adding or modifying a gauge view can be done either using the configuration dialog of a dashboard view (this is the
recommended way), or using the All Views dialog.

Remove a Gauge View

When you remove a gauge view from the configuration of a dashboard view, then only the reference to the gauge
view will be removed; the configuration for the gauge view itself will be preserved. Use the All Views dialog to
delete the gauge view entirely from your system.

Configuration

The configuration of a gauge view is very simple. Currently all that is needed are a filter and a color. 
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5 Using Forms
Now that you know where to find the information. We can now go into detail. The details are found in forms. In this
chapter you will learn how to open a form and change the information.

5.1 Set the Default Form

When you open a form from a view, the default form is used to show you the item. One form may have fewer
fields, but reacts quickly and contains just the right fields for the task. Another form may have the right fields in the
main page, and lesser used fields in the tab pages. Each form is better suited for a specific situation. Forms may be
created for a specific task, or you may have a preference for a certain form that allows you to quickly find what you
need.

To set de default form, do the following;

1. Navigate to a view of the item for which you want to set the default form.

2. Open the application menu, choose New.

Set the default form through the
application menu

3. In the New Item dialog box, the default form will be high lighted. Select the form you want to set as the new
default form.

4. In the lower left hand corner of the New Item dialog box, select the Use this form as default check box.

Use this form as default in the lower left hand corner

5. Click Close.
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The new form is now set as the default form. The next time you open an item, the new default form will be used.

You can open the New Item dialog box in the following alternative ways:

· In the console from the Home tab, open the New list and choose Choose Form....

· In a form of the item for which you want to change the default form.

§ Open the application menu, choose New....

§ From the Home tab, open the New list, Choose Form....

5.2 Navigating Items in Forms

You open a form from a table view. A table view displays many more items than just one. You can move from one
item to the next item in the table view without closing the form.

Items In Forms

To move to the next item in the table view from the form, click Next in the Move group in the form's Home tab.

Mov e command group

In the same Move group you can move to the previous, first and last item of the list in the table view.

When you move to another item, the system will attempt to save the item you leave. Even if you did not change any
field yourself, automatic rules may have changed values. If any field is changed while moving to another item, a
warning about unsaved items is shown.

History Lines

Items are shown in forms and have the above navigation in the form. History lines are shown in History Line
windows. History Line windows have a similar navigation box in the upper right hand corner as forms.

Serv ice C all history  lines
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5.3 Understanding the Information in a Form

PROLIN Smart Client forms are power houses of information. To give the quickest overview of the information in an
item, look for the following.

Display fields

Information from a related item, such as the caller of a Service Call, or a history line, may be displayed in display
fields. While the main information is found in the field itself, below that field is a list with information from the item
selected in the field. Notice the scroll bar on the right hand side of the display field, there may be more lines
available than shown at once.

Example caller display  fields in a serv ice call

Quickview tooltip

In addition to display fields, which take space in your form, the quickview tool tip will give information about the
related item. The quickview tool tip also gives information for items of which the display fields are not activated.
Hover your mouse over the item field for a second and the quickview tool tip appears below the cursor.

Q uickv iew  tool tip for caller in serv ice call

5.4 Required Fields

Some fields may be required. Fields may be required because the values are needed in the process for the item.
Fields may also be necessary because the values are used to create relations with other items. Either way, a
required field must have a value before you save or close the form.
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You can recognize a required field by the thicker left hand border of the field edit box. The indicating border is
usually red,  but the color can be set in the User Options. See Changing Appearance.

Required F ield w ith Inidcator Bar

5.5 Opening an Item in a Form

Forms provide you the details of an item. Depending on your authorizations the form also allows you to change field
values of items.

To open an item in a form do one of the following.

· Double click an item line in a table view.

· Right click on an item line in a table view and choose Open from the context menu.

· Select an item line in a table view, then choose Open Selection in the Item group of the Home tab.

· Select an item line in a table view, then press Enter on the keyboard.

· Select an item then press CTRL and press ARROW DOWN to select multiple items, then press Enter to open all
selected items.

Item lines in a table v iew

See also Navigating Items In Forms.

5.6 Starting Form Actions

Smart Actions are powerful ways of enhancing PROLIN Smart Client with commonly available applications. For
example, it is easy to use Notepad to take quick notes. Notepad can be used in a Smart Action and made available
in all forms. You start actions from the Actions group in a form.

A ctions group
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Link Actions

The Notepad example would be created as a Link Action. A Link action is a Smart Action that uses other
applications and can send basic information from PROLIN Smart Client to the used application. For example,
imagine you use a Notepad action in a configuration item. The configuration item is named "HP Laserjet 5". When
you start the Notepad action, a text file will be created with the name HP Laserjet 5.txt . Before you can use a Link
action the system administrator must create the Link action and make it available to you.

To start a Link action do the following:

1. Open an item in a form.

2. Click Links in the Action group in the form's Home tab.

3. From the Links menu choose an action.

View Actions

When you use a View action, a view will be opened that shows information related to the item in the form. For
example, imagine you are working on a Configuration Item named "HP Laserjet 5" and you want to see any
Problems pertaining to this configuration item. Problems may be directly related to Configuration Items, and
Problems can be related to Service Calls, Incidents and Changes as well. You may be able to simply find the
Problems related to the Configuration Item, but now you want to see the Problems related to any of the Service
Calls and Incidents related to the Configuration Item. In the configuration item there is a list of Calls and Incidents
related to the Configuration Item. You would have to open each Service Call and Incident to see if there is a
Problem created and open. A View action makes life easy. A View could be created that shows Problems related to
Service Calls or Incidents that are registered against a Configuration Item. The View Action adds the name of the
Configuration Item to the filter of the created View.

The View action's result can be any kind of View (table view, chart view, etc.). The View action's result is shown in
a action window. You can use the View action's result just like any other View, and you can place it just like any
action window in the form. When you navigate the form to another item (First, Previous, Next, Last in the Move
group) the View action's result will be updated for the new item. View actions are powerful tools for getting all the
information you need.

Before you can use a View action the system administrator must create the View action and make it available to
you.

To start a View action do the following:

1. Open an item in a form.

2. Click Views in the Action group in the form's Home tab.

3. From the Views menu choose an action.

See also:

· Navigating Items In Forms

· Using Action Windows

· Moving Action Windows
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5.7 Managing Attachments in a Form

Items often have to be documented with information that is best presented in its own format. For example, a
Service Call could be documented with a screen dump of an error situation, Configuration Items could be
documented with a PDF file containing manufacturer's troubleshooting information. Picture files, PDF files and
virtually any other file format can be stored  as attachment. The time it takes to open an attachment depends on
the size of the file and the speed of the network.

You will find attached files in the Attachment window. The attachment window is an action window. Usually the
Attachment window is scrolled up to side of the form.

To add an attachment do the following:

1. Open an item in a form.

2. Click Attachments in the form's Home tab.

3. The Attachment window is now scrolled open and pinned down.

4. Click Add in the Attachment window.

5. A File dialog is opened, locate the file you want as attachment.

6. In the File dialog click Open.

7. The file is now attached to the item and a copy will be uploaded when the item is saved.

8. Select the attachment and from the classification list select an appropriate classification.

C hoose an attachment classification
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NOTE : Notice how the Attachments window name bar shows the number of files attached to the item.

This item has one
attachment

To remove an attachment do the following:

1. Open an item in a form.

2. Click Attachments in the form's Home tab.

3. The Attachment window is now scrolled open and pinned down.

4. Select the attachment you want to remove.

5. Click Remove in the Attachment window.

6. The file is now marked to be removed and will be removed when the item is saved.

If the attachment server is not available, then you will see a problem notification at the bottom of the Attachment
window. In case of a problem, you will not be able to save the attachment.

PROLIN Smart Client can print reports to many formats, also to PDF. Problem documentation can benefit from
regular reports of the chart or view used to analyze the Problem.

See also:

· Using Action Windows

· Moving Action Windows

5.8 Entering Information

A form is used to enter and present information. The fields have different types and each type of information
entered must be entered correctly to have value in the processes. PROLIN Smart Client provides numerous tools to
enter correct values in the fields. In this section you will learn about the tools available for the various field types.
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When you enter invalid information into a field, the field will change appearance. The following image shows a date
field with invalid data.

A  F ield w ith inv alid information entered

If a form contains invalid information, a warning will be shown when you try to save the item. You can then discard
the invalid  information or return to the form to correct the information.

5.8.1 Selecting Options

Options, or more generally speaking, Boolean fields can have various forms. Options can have only two values; the
option is selected or not. The predefined option field is shown as a checkbox.

To select an option, do one of the following.

· Checkbox. Click the check box. A check mark will be shown when the option is selected.

· Radio button. Click the button. The button will appear pressed when the option is selected.

· Yes/No selection. Choose the option from the field's value list.

· True/False selection Choose the option from the fields' value list.

O ption field as a check box

5.8.2 Entering Text

Text fields come in a variety of lengths. Shorter text fields are shown as a one row text box, while longer text fields
are shown as a multi-row text box with possibly a scroll bar.

Text fields can contain any character determined by the character sets on your computer and the database. The
database must be configured to contain Unicode to enter Unicode characters.

In single-line text fields, press Enter  to move to the next field. In multi-line text fields, press Enter  to start a new
line.

Multi-line text field (abov e) and single-line text fields (lower two)

5.8.3 Entering Monetary Values

Monetary or currency values are numeric values. Enter a monetary value by entering a number. When you leave
the field, the number will be formatted as currency.
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Open the monetary value list and a calculator will appear. The calculator allows easy entering of values.

Monetary  fields w ith calculator

In the above picture, a value of $1,000 is being entered in the Planned Cost field. The Planned Cost
(Alternative) field is formatted as U.S. dollars.

The Planned Cost field is formatted with the primary currency format. The Planned Cost (Alternative) field is
a conversion of the Planned Cost field and is formatted according to the secondary currency format. What
currency the primary and secondary currencies are depends on the system settings for currencies.

5.8.4 Entering Date and Time Fields

Date fields contain a specific day from the calendar. Date-time fields contain a specific time of a day from the
calendar.

To set a date field, either type the date in the correct format or select the date in the calendar box. To change the
month click an arrow left or right of the name of the month and year. Alternatively, click on the name of the month
and year. A list of months in the year appears, now select the month. To change the year, click on the name of the
month and year, a list of months in the year appears, now click the arrows left or right of the year number. To
change the year by ten years at a time, click the number of the year above the month list, a list of years appears,
now click the arrows left or right of the year range.

Select the date from the drop down calenar

Relative dates can be entered in the date field. For example, to enter tomorrow as a value type +1  in the field.
Yesterday can be entered as -1 .When you leave the field, the correct date will be shown. In a date field you can
enter relative dates as whole numbers preceded by a plus or minus sign.
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For a date-time field, the calendar box also contains a clock. The calendar works the same as the calendar for the
date field. To change the hours in the clock, double click the hour value and click the arrows up or down. To change
the minutes in the clock, double click the minute value and click the arrows up and down.

Once you have set the date and time, click OK to return the changed value to the field.

Set the date and time

Relative dates can be entered in the date-time field. For example, to enter tomorrow as a value type +1  in the field.
Yesterday can be entered as -1 .When you leave the field, the correct date will be shown. In a date-time field you
can enter relative dates as whole numbers preceded by a plus or minus sign.

5.8.5 Selecting Codes

Code values can have two forms, a list or a hierarchy (tree). Both are easiest selected from the code value list.

A list of code values may also be shown as a set of radio options.

C lick the v alue to select a code

To select a code from a list, open the code selection list and choose the code value. Change the size of the code
selection list to see more values. To change the size of the code selection list, open the list and click and drag the
lower right hand corner of the list.

Resizable code list
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To select a code from a hierarchy, open the code selection list and choose the code value. The hierarchical code
selection lists can be resized too. For easy overview, branches in the code tree can be expanded and collapsed. To
expand a branch, click on the plus sign. To collapse a branch, click the minus sign.

Resizable hierarchical code list

5.8.6 Entering Information in a Lookup Field

Relations to another item are entered in a Lookup field. Lookup fields have a magnifying glass and a Lookup field
menu at the right end of the field.

A  lookup field

To enter a value in the Lookup field, start typing in the field. When PROLIN Smart Client has multiple suggestions
for the value a list will be shown and you can select a value from the list. Continue typing and when only one item
can be suggested from the typed part, the found value will be entered in the field. This function is called the auto
complete function. The auto complete function searches for suggestions based on the search codes of related
items.

Lookup field w ith auto complete

Click on the magnifying glass, this will open Quick Find. Select an item in the view and click Accept in the Quick
Find to return the selected item to the Lookup field. Double clicking an item in the view will also return the item to
the Lookup field.

When you first open Quick Find, items are shown in the default Quick Find view.  To change the view, select
another view from the View list. The types of views that can be selected in Quick Find include table views and
explorer views.



© 2024 PROLIN Inc.

PROLIN Smart Client 2020

Page 87

Start typing a value in the Look for field and the Quick Find will make the selection more specific, showing those
items of which the left column starts with the characters in the Look for field. You can click and drag a column
header to the left most position to look for items based on the new column.

Click Clear to clear the Look for field and show all items in the view again.

Click Cancel to close the Quick Find without returning a selected item to the Lookup field.

Select the item in the quick find and click A ccept

To create a new item and return the new item to the Lookup field, open the Lookup menu and choose New. The
lookup menu also contains tools and actions that are useful for the given field.

The Lookup menu

Using a Lookup field, you create a relation from one item to another item. The item you make a relation with, may
have many relations. For example, you can relate a Service Call to a Person in the Caller Lookup field. There is one
Person in the Caller Lookup field. However, in the Person form there will be a list of Service Calls for which the
Person is related as a caller. This is called a one-to-many relation, one Person may be related to many Service
Calls. Not all one-to-many relations can be seen from both sides.
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5.9 Creating and Changing Relations

Relations contain important information about an item. For example, the relation between a Service Call and a
Person tells for which Person the Service Call is created and so the relation provides the information who to call for
more information about the issue described in the Service Call.

There are three distinct relations in PROLIN Smart Client and each type of relation carries a different type of
information. The relation between a Service Call and a Person is a one-to-many  relation. Many Service Calls may
be created for one Person. One Person may be the user of many CIs. One desktop may have only one user, but
some CIs such a printers have many Persons as users. The relation between a Person and a CI is a many-to-many
relation. Then there is also the Generic relation, this is a special one-to-one  relation. With a Generic relation you
can relate one item to one other item. The generic relations are defined by your company.

In the following sections you will learn about the different relations, what they look like, how to create them and
how to change them.

5.9.1 One-To-Many Relations

One-to-many relations look different from either side of the relation. The Service Call to Person relation is a many-
to-one relation. In the Service Call you will find this relation in the Caller Lookup field:

The Person-Serv ice C all relation in the Serv ice C all form

 From the Person item perspective you will find this (one-to-many) relation in a list of Service Calls:

The Person-Serv ice C all relation in the Person form

To enter information in a Lookup field, see Entering Information in a Lookup Field

In a list of relations, you can create a relation with a new item or you can create a relation to an existing item.

To create a relation to a new item, click Add at the top of the relations list. The default form for creating new
items will appear. See Creating an Item for more information about different ways of creating new items.

To create a relation to an existing item, click Add Relation at the top of the relations list. The advanced find for
the item to relate will appear. See Using Advanced Find for more information. When you have found the item you
want to relate, double-click the item or click Select Item(s) in the Advanced Find dialog. This will return the item
to the list and close the advanced find.
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C lick Select Item(s) in the
Selection Group

To edit the related item, select the item you want to edit and click Edit at the top of the relations list.

To remove the related item from the list, select the item you want to remove and click Remove Relation at the
top of the relations list. Removing an item from a relations list does not remove the item from the system.

The Service Calls list in the Person form does not allow creating or changing relations. The Service Call-Caller
relation is created when the Service Call is created and cannot be changed afterwards. This is a requirement of the
ITIL process. Other items have similar relations that can only be created one time and cannot be changed.

5.9.2 Many-To-Many Relations

Many-to-many relations are shown in similar lists in the items on either side of the relation. In either item, the
relation is shown as a list of items:

The Person-C I relation in the C I form

The Person-C I relation in the Person form

In a list of relations, you can create a relation with a new item or you can create a relation to an existing item.

To create a relation to a new item, click Add at the top of the relations list. The default form for creating new
items will appear. See Creating an Item for more information about different ways of creating new items.

To create a relation to an existing item, click Add Relation at the top of the relations list. The advanced find for
the item to relate will appear. See Using Advanced Find for more information. When you have found the item you
want to relate, double-click the item or click Select Item(s) in the Advanced Find dialog. This will return the item
to the list and close the advanced find.
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C lick Select Item(s) in the
Selection Group

To edit the related item, select the item you want to edit and click Edit at the top of the relations list.

To remove the related item from the list, select the item you want to remove and click Remove Relation at the
top of the relations list. Removing an item from a relations list does not remove the item from the system.

5.9.3 Generic Relations

Generic relations are defined within the company and support company specific processes. Relations between items
carry important information about the two related items. Relations carry the information for processes. Most fixed
relations in PROLIN Smart Client are used in ITIL processes. For example, Work Orders are related to Changes to
show how the Change is actually executed. The configurable generic relations, can be used to fit in company
specific processes.

With generic relations you may connect any item to almost any item. Some restraint must apply to avoid negative
impact on performance. To fit the generic relation in the company's processes the allowed relations must first be
defined. After being defined, the Generic Relations lists must be added to forms to be available to the user.

Generic Relations have a direction, incoming or outgoing. Generic Relations go from one item to another item. The
relations that go out from the current item show up in another list than the items that come into the current item.
The direction of a Generic Relation is again important process information.

To create or edit a Generic Relation, first find the Generic Relations lists. Often these lists can be found in the
Generic Relations tab. In the following image, the list with incoming relations is at the top and the outgoing
relations are at the bottom.

Lists of incoming and outgoing generic relations

· To add a generic relation, click Add above the list of the right direction. The Generic Relation dialog appears.

· To edit a generic relation, select the relation in the list and click Edit above the list. The Generic Relation dialog
appears.
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· To remove a generic relation, select the relation in the list and click Remove above the list.

Dialog for adding or editing generic relations

The current item is preselected and grayed out in the Generic Relation dialog. In the Generic Relation dialog
you can change the generic relation as follows.

1. Choose the type of generic relation from the Type list. The type of generic relation determines the type of item
that can be selected as the related item.

2. Choose an item in the Related Items section of the dialog. In an incoming relation you can select an item in
the From field, in an outgoing relation you can select and item in the To field.

3. Click Apply and Close to save the relation or click Close to discard the changes.

5.10 Copying Item Information

To copy information from an item in a form, do the following:

1. Open the form and select the value in a field.

2. From the Edit group in the Home tab, click Copy. Alternatively press CTRL+C  on the keyboard.

The Edit group in a form

3. To paste the information, switch to another application or to another field that can contain the copied
information. Place the cursor in the field and click Paste in the Edit group. Alternatively, press CTRL+V  on the
keyboard or use the paste functionality of the other application.

NOTE : The Copy menu contains predefined actions to create new items from copied information. See Copy
Information to a New Item.
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5.11 Text Snippets

Text Snippets are available in PROLIN Smart Client 2016 R9 and later.

5.11.1 What are Text Snippets

Text Snippets are pieces of text that can be saved and reused in text fields in forms. They can be very useful if you
want to use standardized pieces of text (for instance for communication to the caller) and don't want to type the
same text over and over again.

They are stored locally on a computer where PROLIN Smart Client runs. The location where they are stored is: C:
\Users\[USERNAME]\AppData\Roaming\PROLIN Inc\PROLIN Smart Client\11 in a file named
snippets.dat.

If you want to share Text Snippets you can distribute the snippets.dat file to other users.

5.11.2 How to use Text Snippets

Text Snippets are available per user. Every user can have its own texts or a standard file can be shared amongst
several users. They are usable in all forms, not linked to specific entity. 

There are three ways to start the Text Snippets dialog:

1. Click on the Text Snippets button on the toolbar

2. Click on the Text Snippets button on the side bar

3. Press Ctrl-T when you are in a text field
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Since it is a general tool window the Text Snippets dialog can be pinned to stay available or even undocked from its
location (similar to the Attachments pane).

Add a text to the Text Snippets list

Open the Text Snippet dialog. Click on the "+" button. You can now enter a name to identify the Text Snippet and
the text itself. The Text Snippets are stored automatically. You don't need to press a button to save.

Modify a Text Snippet
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Open the Text Snippet dialog. Select the Text Snippet you want to modify from the list. The values are shown in the
details at the bottom of the dialog. You can modify the text. The Text Snippets are stored automatically. You don't
need to press a button to save.

Delete a Text Snippet

Open the Text Snippet dialog. Select the Text Snippet you want to delete from the list. Click on the "X" button.
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6 Smart Reporting
The PROLIN Smart Reporting module in PROLIN Smart Suite enables customers to create nicely formatted reports
using all available fields and existing filter functions. These reports can be shared with all end users via PROLIN
Power Server.

In this chapter you learn how to create, run and share reports. You will also learn how to print a view or form and
how to make pictures you can use in a presentation or you can send through e-mail by exporting the view or form.

6.1 Running Reports by End Users

All users have an option to run reports in PROLIN Smart Client. This function can be found under Home - Reports:

End user print function

Users can only access reports from entities they have view rights for.

In the middle section of the screen you can select an entity and under every entity you see the available reports. If
you select a report a preview is shown at the right side of the screen. Under the preview there is some general
information about the report and a button that will run the report.

After you click the Run Report button the following screen is shown (in this case showing the standard Servicecall
detail report):
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User print prev iew  w indow

In this window the generated report is shown. From here it can be viewed, printed and/or exported using the
functions in the ribbon.

6.2 Report Designer

Creating and modifying of reports can be done using the Report Designer which is available in the admin client
and therefore can only be done by users who are a member of the Administrator role.

6.2.1 Start the Report Designer

To start the Report Designer go to Home - Administration - Reporting - Reports

You will get the following screen:
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The main screen shows (per entity) the reports that are saved on the server. 

The Report Designer can be started by either double clicking on an existing report or by clicking the 

 button or the  button on the toolbar.

Reports are stored in the Smart Suite database. If you want to copy reports from one database to another you can
use the Importing/Exporting Reports function.

The Report Designer looks as follows:
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6.2.2 Example reports

Some example reports are distributed with PROLIN Smart Client. These can be found in: c:\[Smart Client
installation folder]\Example Reports. 

The following example reports are available:

Service call

Name Parameters Content

Service call detail Service call ID Shows a single record overview of a set of service call
attributes.

Service call master-detail Service call ID Shows per master service call the history lines and work orders
linked to that service call.

Service call totals Date created from

Date created to

Shows a count of number of service calls for the selected date
range per status, per priority, per assigned to workgroup.

Service call chart Date created from

Date created to

Shows a pie chart of service calls for the selected date range
per category. And a set of bar charts grouped per status,
showing the count per priority.
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Person

Name Parameters Content

User - CI - CI Child User searchcode Shows an overview of the CI's and CI child's per users.

6.2.3 Run Reports from the Designer

In the Report Designer there are three tabs:

On the Report Designer tab you can create and define reports. When you click on either the Print Preview or
HTML View tab the report is executed. The Print Preview shows how the report would look like if it is printed. The
HTML View shows how the reports will look like in an HTML Browser.

6.2.4 Save Reports

Report are saved in the database. This makes it easy to distribute reports to other users.

There are three buttons in the toolbar that control the saving of reports and the information that can be given with
a report:

If you press Save in a new report (or Save As in an existing report) you will get the following dialog:



Page 100 © 2024 PROLIN Inc.

PROLIN Smart Client 2020

In this dialog you can specify some information of the report:

Name: The name of the report. This field is mandatory.

Description: A description of the report. This description is visible by end users if they have access to the
report.

Status: Here you can choose between "Draft" or "Published". If a report has status "Draft" the report can
only be seen by administrators. If the status is "Published" all users with view rights on the entity
this report is created in can see the report.

Location: This controls where the report is available for end users.

Forms: the report is available from the Print menu in forms
Views: the report is available from the Print menu in views in the console
Reports: the report is available under Home - Reports

Reports can be made available on more than one location at the same time.

This dialog can also be opened when you click on the Properties button in the toolbar.

When a report has sub reports you can open them in the same designer (see Sub Reports for more information).
With the Save All button you save all changes in all open reports.

 

 

6.3 Report Editing Basics

This chapter describes the most basic tasks you may encounter when initiating a report edit in the Report Designer.
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6.3.1 Basic Operations

The topics in this section cover the basics of working with reports in the Report Designer.

6.3.1.1 Controls Positioning

This document describes how to easily construct professional looking reports, by precisely aligning their elements to
each other. For this, the two following facilities are introduced in the Report Designer.

· Snap Grid

· Snap Lines

You can choose which mode to use for controls alignment within your report, by setting its Snapping Mode.

Snap Grid

When a report is being designed in the Design Panel, it is lined up by the Snap Grid. This helps to establish the
distance between report elements, and to precisely align them to each other.

To quickly align a control to the report's Snap Grid, right click the control, and in the invoked Context Menu, click
Align To Grid.
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You can choose whether the Snap Grid should be visible, by selecting your report, and setting the Draw the Grid
option in the Property Grid.

You also can adjust the Snap Grid Size, which is measured in the measurement units set for your report.

The Snap to Grid option specifies whether controls are snapped to the Grid when they are moved as usual (with
no additional keys being hold down). When the Snap to Grid option is enabled, the  default move behavior works
in the following way.

· For controls to be aligned to the Snap Grid while being moved:
- Using the keyboard: move them using the ARROW keys.
- Using the mouse: move them as usual.

· For controls to ignore the Snap Grid while being moved:
- Using the keyboard: move them using ARROW keys while hold down CTRL.
- Using the mouse: move them while hold down ALT.
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Disabling the Snap to Grid option swaps the default manipulation to its opposite (you should press CTRL or ALT, to
enable the Grid snapping).

Snap Lines

Instead of the Snap Grid for control positioning and alignment, you can utilize the Snap Lines. These are guidelines
appearing when a control is being moved, and indicating the distance to other report elements (bands and
controls).

For each report element, you can modify its default Snap Line spacing (paddings for bands and Panel, and margins
for other controls) using the Property Grid.

6.3.1.2 Change Measurement Units of a Report

For your report, you can choose its global Measure Units, which can be either Hundredths of an Inch, or
Tenths of a Millimeter.

This can be specified either using the report's Smart Tag ...
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... or via the Property Grid.

This defines the basic measurement unit for all the unit-related options of a report and its bands and controls (such
as location, size, border width, etc.). And, this determines the measurement unit of the report's Snap Grid.

6.3.1.3 Change Page Settings of a Report

In the Report Designer, page settings of a report can be specified in one of two ways. The first approach forces the
default printer settings to be used when the report is printed, while the other one enables you to alter page settings
independently.



© 2024 PROLIN Inc.

PROLIN Smart Client 2020

Page 105

· Using settings of the default printer

For the orientation, margins and paper size, you can specify a requirement that applies the corresponding printer
settings instead of the report's. In this instance, the page properties in the Property Grid are disabled and displayed
as grayed out. This may be useful when the report is printed in several places with different printers and printer
settings.

· Specify the report's page settings

While designing the report, you can specify the page settings via the Property Grid:
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You can set the page orientation and modify the margins. The margin values are expressed in the report's
measurement units. You can select from the predefined paper sizes (Paper Kind property), choose Custom and
create your own paper size, or select one which is already defined for this printer (Paper Name property).

These settings affect the layout of the report's design surface. After their modification, you may notice red warning
marks, indicating that the controls go beyond the page width. These warnings can be switched off by setting the
Show Printing Warnings property of the report to No.

· Modify the settings in Preview Tab

The report's Preview Tab toolbar has a corresponding button that enables you to modify the page settings. Clicking
this button invokes the Page Setup dialog, which allows you to adjust the page layout before printing or exporting,
and select the printer.
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The margins can also be set visually by dragging the dashed lines in the Preview Tab as needed.

To change the measurement units shown in the margins tooltips, customize the report's Measure Units property.

Measure Units = Hundredths of an Inch
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Measure Units = Tenths of a Millimeter

6.3.2 Report Types

The tutorials in this section provide you detailed instructions on how to create reports of different types with the
Report Designer.

6.3.2.1 Table Report

This tutorial describes the steps to create a table report, which means that the report's data is arranged into a
table-like layout. This feature should not be confused with the master-detail report or cross-tab report.

To create a table report, follow the steps below.

1. Create a new report.

2. Bind the report to a data source.

3. To add a Page Header to the report, right-click anywhere on the report's surface, and in the invoked Context
Menu, choose Insert Band | Page Header.
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4. Now, add two Table controls to the report's Page Header and Detail band.

To do this, in the Toolbox, click the Table icon. Then, in the Page Header's content area, click and hold down the
left mouse button while dragging the mouse cursor across the Detail band.

As a result, two tables are created. One will be used as a header, and the other one - for the report's detail
information.

5. Type the headers into the upper table's cells, and bind the corresponding cells in the detail section to the
appropriate data fields. This can be done by simply dropping these fields from the Field List onto the cells.
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6. Finally, you can customize various properties of the tables, to improve their appearance. For example, using the
Property Grid you can define their Borders, as well as Background Color. To customize the cells' text options, use
the Formatting Toolbar.

A noteworthy feature is the capability to specify odd-even styles for the detail table.

6.3.2.2 Label Report

This tutorial describes the steps to create a label report containing employee badges, using the Report Wizard.

To create a label report, do the following:

1. In the Main Menu, select File and click New with Wizard... (or press CTRL+W).

2. Next, the Wizard will guide you through the process of creating a label report. For detailed instructions on the
wizard's steps, refer to Label Report Wizard.

3. Bind the report to a data source containing information about employees.

4. Finally, drop the required fields from the Field List onto the available Detail band's area, and customize their
layout.

Note that you can employ the mail merge, to combine multiple data fields within the same control.
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6.3.2.3 Master-Detail Report (Detail Report Bands)

This tutorial describes the steps to create a master-detail report (or, invoice report) with hierarchically linked data,
using the Detail Report band.

Design a Master-Detail Report

To create the layout of a master-detail report, do the following:

1. Allocate parts of a master report on the report's Detail Band.

For the master report to be generated properly, the report's Data Member should be set to the master query. If you
added the master query first, this property is set to the required value automatically. To manually specify the data
member, click the report's smart tag and in the invoked actions list, expand the drop-down list for the Data Member
property and select the master query.

2. Now, to add a detail report band, right-click anywhere on the report's surface, and in the invoked Context Menu,
point to Insert Detail Report. When the report's data source contains a data relationship, it is displayed in the
Context Menu.

3. Then, drop the required data fields from the Field List onto the detail report band.

Note that you should drop items from the relation node (in this example it is the CategoriesProducts section), for
the detail report to be generated correctly.
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View the Result

The master-detail report is now ready. Switch to the Preview Tab, and view the result.
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6.3.2.4 Multi-Column Report

This tutorial describes the steps to create a multi-column report, meaning that each page of the report document is
laid out in a specified number of columns.

To demonstrate the multi-column feature, we'll use a report with grouping.

1. Select the Detail band, and in the Property Grid, expand the Multi-Column Options section.

First, set the required Mode. It determines whether the number of columns is manually specified, or it depends on
the fixed column width.
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2. Then, if you've chosen to Use Column Count, set the Column Count to 2, and Column Spacing to 10.

The Direction determines the order in which records of the same group are processed.

3. Now, on the Detail band's surface a grey area appears, delimiting the available column's width. Adjust the
controls width, so that they fit within the effective borders.

The multi-column report is now ready. Switch to the Preview Tab, and view the result.
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6.3.3 Navigation
The tutorials of this section cover the navigation-related features of the Report Designer.

6.3.3.1 Add Bookmarks

This tutorial describes the steps to create a report with bookmarks (a so-called Document Map). This feature allows
you to easily navigate through the report during print preview.

To demonstrate the Document Map feature, we'll use a report with grouping.

To create a report with bookmarks, do the following:

1. Click the Label in the Report Header band, to select it, and in the Property Grid, set its Bookmark property to the
same value as its text (i.e. Products by Categories).
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2. Now, select the Label in the report's Group Header band. As this control is bound to data, we will bind its
Bookmark property to the same data field, using the (Data Bindings) property.

Note that as with other bindable properties, you also can apply value formatting to the Bookmark property (e.g.
Category {0}).

3. Then, for this Label, specify its Bookmark, and set the Parent Bookmark property to the Report
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The report with bookmarks is now ready. Switch to the Preview Tab, and view the result.
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6.3.3.2 Create Hyperlinks

This tutorial demonstrates how to embed a hyperlink into your report.

Note that a label will behave as a hyperlink both in a report's Print preview, HTML preview and when the report is
exported to PDF, HTML, MHT, RTF, XLS and XLSX formats.

To insert a hyperlink into your report, do the following:

1. Create a new report or open an existing report.

2. Drop a Label onto the report, and in the Property Grid, change its Text to the one required for the link.

In addition, to make the Label look like a typical link, you can change its appearance appropriately (e.g. make it blue
and underlined).

3. Now, set its Navigation Target to the required value (_blank, _parent, _s earch, _s elf, or _top), and define the
required Navigation URL.

The hyperlink is now ready. Switch to the Preview Tab (or, HTML View Tab), and view the result.
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6.3.3.3 Add a Cross-Reference

This tutorial demonstrates how to add a cross-reference to your report. A cross-reference is simply a link whose
target is located within the current document, which allows you to establish easy navigation through a report. In
this example, we place a link at the bottom of each group, leading to the beginning of the report.

To demonstrate this feature, we'll use a report with grouping.

To create a report with cross-references, do the following:

1. Drop a label onto the created ReportHeader band, which will serve as the report's headline. Click the label, to
type the desired contents into it. Then, in the Property Grid, set its Name property to reportTop.

2. To accompany the existing Group Header with the corresponding Footer, in the Group and Sort Panel, check the
Show Footer option.

Then, drop a label onto it. As it will be the link, change its Text to Top of Report, and apply the desired
formatting to it (e.g. the blue color and underlined text).

Set its Navigation Target property to _self. Then, if you click the drop-down list of the Navigation URL property,
you can see the controls available in your report. Choose the one named reportTop.

The report with cross-references is now ready. Switch to the Preview Tab (or, HTML View Tab), and view the
result.
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6.3.4 Styles and Conditional Formatting
The topics of this section cover appearance-related information about the Report Designer.

6.3.4.1 Understanding Style Concepts

The Appearance Properties

In the Report Designer, a report and each of its elements (bands and controls) has a complete set of appearance
options (such as Background Color, Borders, Font, Foreground Color, Text Alignment, etc.). By default,
these properties aren't specified, meaning that their real values are obtained from a control's (or band's) parent,
which is the report itself. So, the appearance, specified for a report, is distributed to all its child elements. Similarly,
the appearance of a band is translated to the controls it contains.
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In turn, a control's appearance can be adjusted independently from its parent.

When it is required to reset a value assigned to a control's appearance property, you can right-click this property in
the Property Grid, and in the invoked menu, click Reset. So, the control will be restored to the appearance of its
parent.
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Styles Priority and Inheritance

To differentiate appearance settings in your report, you can create comprehensive styles (which are stored in the

report's style sheet), and then can be assigned to individual elements. There are two ways to store a report's

styles.

· to save them to external files (with REPSS extension), and then load them to a report via its Style Sheet Path
property;

· to store the styles within the report, so that they can be easily accessed via its Style Sheet property.

Note that if styles contained in a style sheet loaded via the Style Sheet Path property have the same names as
styles already contained in a report, the latter ones are overridden.

When both styles and individual appearance settings are assigned to an element, you can control the priority of
their differing options, via an element's Style Priority property.

By default, most of the Style Priority's options (Use Background Color, Use Border Color, etc.) are set to
Yes.

This means that if any style is assigned to a control, its properties will have a higher priority than the appearance
properties of this element or its parent. You can assign a higher priority to an element's appearance property, by
disabling the corresponding Use* property.
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The same principles are applied to the odd-even s tyles feature, which allows you to alternate the appearance of
consecutive data rows in your report. For details on this, refer to Use Odd and Even Styles.

NOTE When conditional formatting is applied to an element, its appearance definition has the highest priority.

6.3.4.2 Use Odd and Even Styles

This tutorial describes how to apply odd and even s tyles to report controls, e.g. to alternate the background color
for each record.

To utilize odd and even styles, do the following:

1. Create a table report.

2. Select the detail table, and in the Property Grid, expand its Styles.

Invoke the drop-down list for the Even Style, and click (New).
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This will create a style and assign it to the control's Even Style.

3. Now, expand the Even Style property, and adjust the required options, e.g. set the Background Color to
ControlLight.

If required, perform the same steps, to create and assign an odd style, as well.
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6.3.4.3 Conditionally Hide Bands

To demonstrate this feature, we'll use a report with grouping.

To conditionally hide bands in a report, do the following:

1. Select the Group Header, and click its Smart Tag. Then, in the invoked actions list, click the ellipsis button for the
Formatting Rules option.
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In the invoked Formatting Rules Editor, click the Edit Rule Sheet... button.

2. Now, in the invoked Formatting Rule Sheet Editor, click the button, to create a new rule. Then, set its Visible
property to No, and click the ellipsis button for the Condition property.
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3. Construct the required logical expression (e.g. [CategoryID] < 2), and click OK.
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To quit the Formatting Rule Sheet Editor, click Close.

4. Back in the Formatting Rules Editor, move the created rule to the dialog's right section (Applied Rules), to
make it active.

And, do the same for the report's Detail band. That is, click the ellipsis button for its Formatting Rules property, and
in the invoked dialog, apply the same rule to this band, as well.
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Switch to the Preview Tab, and view the result. In our example, you can see that the first category isn't shown. So,
the conditional formatting was applied properly.

6.3.4.4 Conditionally Change a Label's Text

This tutorial demonstrates how to change a label's text if a certain condition is met, without using scripts.

To conditionally change a label's text, do the following:

1. Create a new report or open an existing one.

2. To create a calculated field, in the Field List, right-click any item inside the created dataset, and on the invoked
menu, choose Add Calculated Field.
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3. Select the calculated field, and in the Property Grid, set its Field Type to String. Then, click the ellipsis button
for its Expression property.

And, in the invoked Expression Editor, define the required logical condition for the calculated field (e.g.
Iif([UnitsOnOrder] == 0, 'None', [UnitsOnOrder]), which means that if the UnitsOnOrder data field's value is
equal to 0, the control's text will be replaced with None).
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To save the changes and close the dialog, click OK.

4. Finally, drop the required data fields (and the created calculated field as well) from the Field List onto the
report's Detail band.

The report is now ready. Switch to the Preview Tab, and view the result.
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6.3.5 Change the Layout of Report Elements

To select a control, click it. To select the next control in tab order, press TAB. To select the previous control in tab
order, click SHIFT + TAB.

Individual controls can be moved, using either mouse or keyboard.

They can be precisely aligned to each other using either Snap Gird or Snap Lines. For details on this, refer to
Controls Positioning.

To resize a control using the mouse, select it, and then drag a rectangle drawn on its edge or corner.
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To resize a band, drag its header strip.

To resize an element using the keyboard, press SHIFT+ARROW or CTRL+SHIFT+ARROW.

To select multiple elements, do one of the following.

· Click elements while holding CTRL or SHIFT.

· Click on a blank space and drag the mouse to create a selection frame. When the mouse button is released, all
controls within the selection frame's boundaries will be selected. In this case, the previous selection is cleared.

You can also easily align multiple controls or make them the same size, by utilizing the Layout Toolbar.

6.3.6 Change Fonts and Colors of Report Elements

To change fonts and colors (as well as paddings, text alignment and other appearance properties) of a report

control or band, select this element and do one of the following.

· Use the Formatting Toolbar.
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Use the Property Grid, where all appearance-related properties are located under the Appearance category.

Note that the appearance settings of a band are applied to all controls contained within it.

When it's required to apply styles in bulk, we recommend using common style templates, which also can be stored
in an external style sheet file, and applied to multiple reports. In addition, this allows you to specify separate
odd/even styles, to improve your reports' readability. Another noteworthy option, is the capability to conditionally
change the appearance of report elements based on a certain logical  expression (e.g. if a control's value satisfies
some rule).

6.3.7 Delete Report Elements

To delete a report element (band or control), select it in the Design Panel or Report Explorer (to select multiple
elements, hold down SHIFT while selecting), and then do one of the following.

· Press DELETE.

· Right-click the report element, and in the invoked Context Menu, choose Delete.



© 2024 PROLIN Inc.

PROLIN Smart Client 2020

Page 135

· In the Main Menu, select Edit | Delete.

NOTE: You can cancel the operation by pressing CTRL+Z.

Note that certain elements cannot be deleted (such as the Detail band).

6.3.8 Add or Modify Static Information in Your Report

In a report, static and dynamic information is displayed using appropriate controls.

Dynamic information changes through a report, such as values from a database (which comprise the main report
data) or service information (such as current user name or page numbers).  Approaches to embed dynamic
information to your report are detailed in the following document: Displaying Values from a Database (Binding
Report Elements to Data).

Static information is text or images that aren't obtained from a data source, and therefore don't change through
the report, and don't depend on the current computer. Static information can be printed only once (e.g. in a Report
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Header), can repeat on each page (e.g. in a Page Header) or can repeat with every entry in your report's data
source (a data-bound label, which is placed onto the Detail band).

Static information can be either edited in-place, or loaded from an external file.

Change Static Information

Text elements (e.g. Labels and Rich Text Boxes) allow in-place editing of their content. Simply double-click an
element and activate the editor.

Load Static Information to Your Report

To load static information to your report from an external file, drop an appropriate control from the Control Toolbox
(e.g. Label, Rich Text Box or Picture Box). After it is properly positioned, edit its content using the Smart Tag.

For instance, the following instructions describe how to display a rich text (a formatted text with embedded images)
into your report.

1. Drop the Rich Text control from the Toolbox onto the Detail band.
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2. To load content from an external RTF or TXT file, select the created control and click its Smart Tag. In the
invoked actions list, click the Load File... link.

Then, in the invoked dialog, locate the required file, and click Open.

6.3.9 Use Mail Merge in Report Elements

The mail merge feature allows you to combine both static and dynamic content within the same control (e.g. to
append some text prefix or postfix to a value obtained from a database), or even bind a control to multiple data
fields at one time.

Mail merge is available for the following controls.

· Bar Code

· Check Box

· Label

· Rich Text

· Table Cell

· Zip Code
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To embed dynamic data into a control's static content, type in data field names surrounded by [square brackets].

6.3.10 Add Calculated Fields to a Report

This document demonstrates how to add a calculated field to a report. The main purpose of calculated fields is to
perform pre-calculations (of virtually any level of complexity) over data fields. 

In the Report Designer, a calculated field is similar to an ordinary data field (e.g. you can bind controls to it, and
group, sort and filter your report against it).

To add a calculated field to your report, follow the instructions below.

1. To create a calculated field, in the Field List, right-click any data member, and on the invoked menu, choose Add
Calculated Field.
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2. In the Field List, select the created field to show its properties in the Property Grid. Among these
options, make sure to change the Field Type property to an appropriate value.

3. Now, let's create an expression for the calculated field.

Click the ellipsis button in the Expression section, to invoke the Expression Editor. You can also invoke this dialog by
right-clicking your calculated field within the Field List and selecting Edit Expression...
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Click Fields to see the field list. Double-click field names to add them to the expression string. Use the toolbar to
add operators between field names.

NOTE that it's also possible to employ parameters in a calculated field's expression.

To close the dialog and save the expression, click OK.

4. Finally, drag the calculated field from the Field List onto the required band, just like an ordinary data field.

6.3.11 Add Parameters to a Report

For your report, you can employ parameters, which can be requested each time the report is being previewed.
And, based on specified values, the report will then being filtered. It is also possible to employ parameters in
expressions of calculated fields.
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In this example, we'll create two date-time parameters, to filter out orders which don't fall in the specified range,
from the report.

To add parameters and filter your report based on their values, follow the steps below.

1. In the Field List window, right-click over the Parameters section and in the invoked menu, click Add
Parameter.

2. In the invoked window for the created parameter, set its Name and Description. And, make sure to set its
Type to an appropriate value.
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NOTE In Print Preview, the report's document is not generated until you have submitted values of all the parameters
that have the Show in the parameters panel option switched on via the Parameters UI.

3. Enabling the Supports the collection of standard values option of the parameter allows end-users to modify
its value and also activates the Dynamic values and the Static values tabs of the window:

- On the Dynamic values tab, you can specify a parameter's data source, data adapter and data member. The
value member defines a data field that provides values to the parameter. The display member defines a data field
that provides display names for parameter values (how these values appear in the user interface available in a Print
Preview).

- On the Static values tab, you can manually fill the list of parameter values, with each value having an individual
description (specifying how this value appears in the Parameters panel).

Then, repeat the previous steps to create the second parameter, so that every time your report is previewed, you
will be asked to specify two dates.

6.3.12 Change Value Formatting of Report Elements

To apply value formatting for a data-bound control's content (e.g. for it to be treated as currency, or date-time
content), locate this control, click its Smart Tag, and in the invoked actions list, click the ellipsis button for the
Format String entry.

Then, in the invoked format string editor, choose one of the predefined formatting styles, or specify a custom one.
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To quit the dialog and apply the changes, click OK.

Similarly, when the mail-merge is employed for a control's dynamic content, to apply a value formatting to an
embedded data field, select it in the in-place editor, and click the control's smart tag. Then, in the invoked actions
list, specify the required format.

Note that when a s ummary function is being applied to a control's dynamic content, value formatting is applied
separately, via the Summary Editor.

Independently from the general (or, summary) value formatting, you can specify a native XLSX format string, which
is to be preserved when the report is being exported to XLSX. This can be done via a control's Xlsx Format String
property.
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6.3.13 Change or Apply Data Filtering to a Report

For your report, you can specify a filtering expression (of virtually any level of complexity), to exclude excessive or
undesired data.

To filter a report's data, click the Filter button in the Ribbon:

You will get the well known filter dialog that you also get in the Advanced Find function:
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6.3.14 Change or Apply Data Grouping to a Report

This document demonstrates how to group a report's data. Note that data grouping can be performed only if a
report is bound to a data source.

To group records in a report, do the following:

1. Create a new report or open an existing report.

2. Now, switch to the Group and Sort Panel, and click Add a Group. In the invoked list, choose a data member
across which the report is to be grouped. Note that grouping across calculated fields is supported, as well.

If multiple groups are created, you can specify the priority for each group, by selecting it in the Group and Sort
Panel, and using the Move Up and Move Down buttons.

3. After this, a Group Header band is added to the report, with the specified data member being set as its grouping
criterion.

Now, it's only left to drop the corresponding item from the Field List onto this band, so that it's displayed as a
header for each group.

If required, you also can apply mail merge to this label.

4. In addition, you can enable the corresponding Group Footer band, by checking the Show Footer option in the
Group and Sort Panel.
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To manage the sorting order of the group's items (ascending or descending), use the Sort Order drop down list.

5. Then, you can calculate a total across the group, by placing a Label onto this band, and specifying its Summary
properties in the following way.

Note also that value formatting is applied to a summary independently of the general formatting, and has a greater
priority.

6.3.15 Add Totals to a Report

With Report Designer, you can force a data-bound control to calculate one of the standard summary functions
(Average, Summary, Count, Running Summary, Percentage, Max or Min).

To calculate summaries (totals) within a report, follow the instructions below.

1. To display the result at the bottom of a report, the Report Footer band should be present. To add it, right-click
anywhere over the report's area and in the invoked Context Menu, select Insert Band | ReportFooter.
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2.Click the field for which a summary will be calculated, to select it. Then, hold down CTRL and drag the field onto
the Report Footer area, to create an exact copy of the Label that will display the summary.

3.Now, select the newly created Label, click its Smart Tag, and in its actions list, click the ellipsis button for the
Summary item. And, in the invoked Summary Editor, specify the summary options.

The following image shows an example of how you can set up your total. Note that the Summary Running option is
set to Report, to ensure that all values from the specified data field are taken into account.
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NOTE: The Ignore NULL values option won't affect the result in this example, since NULL values are treated like
zeros, by default. So, Sum won't change whether these values are taken into account or  not. This option makes
sense for functions like Count or Average, because the number of elements counted will depend on it.

Note also that value formatting is applied to a summary independently of the general formatting, and has a greater
priority.
When calculating totals for groups, you can sort the groups against a summary function result.
To save the settings and close the dialog, click OK.

6.3.16 Add Page Numbers and System Information to a
Report

This document describes how to insert page numbers or other system information (e.g. current date and time, us
er name, etc.) into a report.

Generally, this information is displayed within the Page Header and Footer or Page Margin bands. To add page
numbers or system information to a report, locate the Control Toolbox and drag and drop the Page Info control.
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Then, follow the instructions below for your specific task.

· Add Page Numbers

· Add System Date and Time

· Add the User Name

Add Page Numbers

1. Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down list for
the Page Information entry.\

Select whether to display only the page number (Latin or Roman - uppercase or lowercase), or the current page
number with total pages.

2. To format the control's text, via its Smart Tag, invoked its actions list, and specify the required format (e.g.
Page {0} of {1}).
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3. Using the control's actions list, you also can specify the s tarting page number, and the running band (e.g. this
option is available when there are groups in a report, and it's required to apply independent page numbering for
them). For details on this, refer to Add Page Numbers for Groups.

The result is shown below.

Add System Date and Time

1. Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down list for
the Page Information entry, and select Current Date and Time.
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2. To format the control's text, via its Smart Tag, invoked its actions list, and specify the required format.

You can either type it in the Format field, or, click its ellipsis button and use the Format String Editor.

The result is shown below.

Add the User Name
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1.Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down list for
the Page Information entry, and select User Name.

2. To format the control's text, via its Smart Tag, invoke its actions list, and specify the required format (e.g.
Current User: {0}).

The result is shown below.

6.4 Advanced Report topics

With the help of the Report Designer, you can edit existing reports, as well as create your own reports from
scratch. The following sections contain tutorials providing step-by-step instructions on both basic and advanced
report customization.
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6.4.1 Use parameters in filters

To use parameters at runtime and use these in your report's filter take the steps described below.

Open or create a report and go to the Field List control:

Right click on the Parameters branch and select Add parameter.

Fill in the necessary information.

Show in the parameters panel - if checked this parameter is shown when running the report so a value can be
filled in.
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Supports the collection of standard values - If checked you can define a static or dynamic list the user can
choose a value from when running the report.

Allow multiple values - If checked the user can select more than one value to pass on to the report.

In order to use the parameter as value in the filter go to the filter by clicking the Filter button on the ribbon. In the
filter window go to the advanced panel and select the field you wish to use. Then select Parameter. You can now
choose from the available parameters:

Click OK twice and then run your report.

You will see a panel on the left side with the parameter(s) you defined. You can enter a value here and press
Submit to run the report.
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6.4.2 Charts

Smart Reporting supports a wide range of charts that can be used to enhance your reports:

Charts can be configured in a lot of ways. The following chapter describes how to create a basic bar chart.

6.4.2.1 Create chart

This chapter describes how to create a basic bar chart which will count the number of service calls per status.

Go to the Administration - Reporting - Reports function and then select the Service call entity.

Create a new report.

In this report create a new GroupHeader Band:
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Then select Chart from the Toolbox on the left and drag that to the newly created Band.

When the chart item is dropped on the report you automatically get the following dialog:
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Go to the Series Collection on the left side and click the + to create a new series.

Choose for Bar

Go to the Properties tab on the right and scroll to the Data section.

Fill in Status as ArgumentDataMember

Fill in COUNT() as SummaryFunction

Press the OK button

Click on the Print preview tab in the Report Designer.
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Your chart will look something like this:

To further modify the chart you can go back to the chart designer by clicking on the  icon next to the chart (the
icon is only visible if you have selected the chart item in the Report Designer).

You will get a context menu where you can select Run Designer... to go to the chart designer:
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6.4.2.2 Link Chart to Group Data

Charts use the report filter to filter the data that they are showing. They are not automatically using grouped data
to modify their filter. If you want to do that you need to use a little piece of script to dynamically set the filter of the
chart.

In this example we are going to create a report that shows a chart of Service Calls per Status and break that down
per Category.

Create a new report.

Click on the Add a Group button in the Group and Sort section in the Report Designer and select Category:

This will automatically create a new GroupHeader Band.

In this band create the chart as was explained in Create chart

Then place the Category field in this GroupHeader Band by dragging it from the Field List to the report:
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If you now run the report you will get a chart per Category but all charts have the same data.

To change this add scripting to the report.

Click on the button Scripts in the toolbar and add a Before Print script for the chart that looks like this:

private void chart1_BeforePrint(object sender, System.Drawing.Printing.PrintEventArgs

e) {

    XRChart xrc = (XRChart)sender;

    // Gets the current value of the grouping field. 

    // For the master-detail report, use DetailBand.GetCurrentColumnValue in the detail

band instead. 

    var filter_value = GetCurrentColumnValue("Category");

    // Clears the filters that may have been set earlier. 

    xrc.Series[0].DataFilters.Clear();

    // Creates and adds a new filter to the "TheGroupingField" data field  

    // that has the type System.String.  

    // The condition is that the data value equals the filter_value parameter. 

    xrc.Series[0].DataFilters.Add(new DataFilter("Category", "System.Object" , 

        DataFilterCondition.Equal, filter_value));

}



Page 162 © 2024 PROLIN Inc.

PROLIN Smart Client 2020

This will look like this in the Report Designer:

If you now run the report the data in every chart matches the Category it belongs to.

6.4.3 Sub Reports

The sub report function can be used to create reports that show information from multiple entities in one report.
This function let's you include one or more report(s) in a main report so you can run all reports at once and create
one output file.

To include one report in another, open an existing report or create a new one. Then drag and drop the Sub-
Report item from the toolbox on to the report.

Then go to the Report Source Url property of the Sub-Report item and click on the list icon at the end of the
field to open a dialog where you can choose a report to be included in your report.
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Reports that are linked as sub report can be maintained as a standalone report in the Report Designer but they can
also be opened in a separate tab if you double click on the Sub-Report item.

6.4.3.1 Pass Parameters to Sub Report

You can pass values to a sub report to filter data based on a report value or parameters that are entered for the
main report.

To do this create a parameter in the sub report and make sure to disable Show in the parameters panel

For example:
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 Then in the main report do to the Sub-Report item and open the context menu and choose for Edit Parameter
Bindings.

This opens the following dialog:
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Click on the Sync button. Automatically an entry will be made that will contain the parameter from the sub report
that you have created before.

Now select in the Binding field which field or parameter's value should be used to pass on to the sub report. Press
OK and save the report to store the changes.
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6.5 Importing/Exporting Reports

Reports can be exported and imported using a wizard that can be found under Administration - Reporting -
Reports - Open

After selecting the menu you will get the following dialog that lets you choose if you want to export or import
report(s).
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Importing Report(s)

If you choose to import one or more reports you will get the following dialog asking for the location of the file.

This can be a single report (extension .repx) or a zip file containing more than one reports (extension .repz)
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There are two options on how PROLIN Smart Client will act if the reports you try to import already exist:

Skip existing report: If the report already exist in the database it will not be imported.
Replace existing reports: Existing reports will be overwritten by the reports you are importing.

After choosing the report file and pressing Next the report(s) that exist in that file are shown. You can now select
them for import by clicking on the Add>> button. 
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Click Next in this and the following screens to import the report(s).

If you open an imported report which has fields that are not existing in the database you import them in you will get
a dialog that looks as this:
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This shows the field(s) that are not existing and you can choose an alternative destination.

Exporting Report(s)

If you have chosen to export existing reports you will get the following dialog:
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You can select per Item Type which reports you want to export.

After pressing Next you must specify the filename to which the reports will be exported.
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You have two options for exporting:

Export embedded subreports: if a report has subreport(s) these will be automatically exported if this option is
checked.

Delete exported reports from the server: If this option has been selected the reports that have been exported
will be removed from the database.

6.6 Starting reports from a Form or View

You can run reports from a Form or View. When you do this the selected record(s) are printed in the report.

To do this you must make the reports you want to use in Forms and Views available by checking the correct
location option in the report properties. See Save Reports for more information.

From a form go to Home - Print, from a view go to Home - Print or choose Print from the context menu. 

You will then get this dialog:
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The first option in the left hand panel is the Preview function that was used in Smart Client until now in the
Print/Print preview functions.

Below the Preview option there is a list of available reports. By selecting one of the reports you will see the preview
of that report in the right hand panel.

The report will always show the record that you have selected in the form (or the record(s) that you selected in the
view). The filter that has been defined in the report is disregarded when the report is called from a form or view.

6.7 Changing the Print Layout

When you print a view or form directly, a default layout and default settings are used. Usually these settings are
good. In PROLIN Smart Client you have the flexibility to change the layout of the printed view or form.

To change the layout of a printed view or form, do the following:

1. Open the view and choose Print Preview from the Application menu.

Lay out options for a printed v iew  or form
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2. A Preview window is shown.

3. Do any of the following

· Click Options in the window's Print group. In the Print Options dialog you can choose what you want to
print and how you want to print.

· Click Scale in the Page Setup group to fit the view or form to the printable page or to resize it larger or
smaller.

· Click Header/Footer in the Page Setup group to add and edit the header and the footer of the report's
pages.

· Click the Page Background command or the Watermark command to change the background of the
printed view or form.

4. To print the view or form:

· Click Print to open the Print dialog. Choose the printer and options and click Print.

· Click Quick Print to print to the default printer.

NOTES  Notes on the options in the Print Options dialog.

If you print a table view

· Select the Selected Rows option, in the Options tab page, to show only the lines or groups selected in the
console's table view to be printed. This option allows to hide some of the lines from a table view.

· Select the Auto Width option, in the Behavior tab page, to stretch to view to the width of the page. If you clear
the Auto Width option, the lines in a table view will take the size as they appear in the console's table view.

If you print a chart view

· Select the None option (for no resizing) to use the current rendering of the console's chart view. If the current
rendering is small, then the resulting report may have a low quality picture.

Forms and Scheduler Views have no print options.
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7 Doing Daily Tasks
PROLIN Smart Client provides numerous ways to make your daily tasks easy. In this chapter you will learn how to
make best use of PROLIN Smart Client technology.

7.1 Working with My Tasks

Starting your day with the My Tasks view puts you in charge of your time. In one look you see the items assigned to
you, to your group and the approval tasks waiting for your attention. The My Tasks view is the perfect location to
assess your workload of the day.

These are suggestions to give you a good start of the day:

· Review the approval tasks assigned to you. Decide whether you can approve to task, have to reject it or must find
information before you can make a decision.

· Make a to do list for your day in the Items assigned to me view. Depending on the procedures of your
organization, you may assign items from your group to yourself. The item will then automatically move from the
Items assigned to my group view to the Items assigned to me view.

· When you manage the assignments list of a group, you may review the Items assigned to my group list and
assign the items to individual Persons. The items will then be shown in the Items assigned to me view of the
assigned Person.
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7.2 Working with Service Today

Starting your day with Service Today allows you to manage several lists. When you manage the workload of a
Workgroup, it may be easier to start in Service Today. When you manage only your own workload, it may be easier
to work from the My Tasks view. 

Serv ice Today  example

Service Today lets you focus on one list of items at the time. The Service Today views show items that can be
assigned (Service Calls, Incidents, Problems, Work Orders, Changes and Project) to Persons or Workgroups. Each
view can show you the items assigned to the current user of the client (you), to the Workgroup of the current user
(your Workgroup) or a selected user or Workgroup.

To determine which assignment is viewed, do the following:

1. Open the table view for which you want to determine the assignment.

2. In the View tab, click All View Options.

3. In the navigate view of the View Options dialog, choose the Filter group.

4. In the More Choices tab page select the right options.

5. When you want to select a specific user or group that is not you or your group, then clear all options in the More
Choices tab page. Turn to the General tab page and select a specific user in the Assignment>To Person field
or the Assignment>To Workgroup field. 

6. Click OK to close the View Options dialog.

See also:

· Working With My Tasks

7.3 Using Advanced Find

The database you use with PROLIN Smart Client may contain a large amount of information. Easily finding
information is important. At any time and at any moment you may want to use Advanced Find.

To use Advanced Find do the following:
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1. Click Advanced find, in the Tools group on the Home tab.

A dv anced F ind in the Tools
command group

2. The advanced find opens with the Query Composer  open. If the Query Composer  is not open, click the Query
Composer tab at the bottom of the dialog or click Compose in the Filter group.

The adv anced find dialog

3. In the Query Composer, select the item you are looking for in the Search for field.

4. Select the view you want to use for the results in the View field.

A dv anced find composer
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5. Now you can enter search criteria

· In the General tab page you can use commonly used search criteria.

· In the More Choices tab page you can use predefined search criteria.

· For more information about the Advanced tab page, see Editing Filters.

More C hoices

A dv anced Settings

6. Once you have selected your search criteria, click Find Now. Every time you change the search criteria, click
Find Now to see the results. 

7. A change from your Service Management System is that Advanced Find always uses "contains" to search on a
text string if you don't add any search wildcards. If you add wildcards the exact string plus wildcards are used.
For example, if you search in the description field on "print" it finds all records that have the word "print" in the
description. However if you enter "print*" all records are found where the description starts with "print".

8. The search result is now shown in the result view, the Query Composer window can be closed to gain more
room for the results.

To clear the currently set conditions, click New Filter in the Filter group.
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For advanced users the Executed Query action window shows the used query after you have clicked Find Now.

Executed Q uery

You can save and later re-use an advanced find filter. To save a search filter, click Save in the Filter group.
Navigate to a convenient location and save the filter. To open a search filter, click Open in the Filter group.
Navigate to the location where you store filters select a filter and open the filter. The Open menu will show recently
opened filters.

7.3.1 Global Search

The Advanced Find dialog contains an extra button "Global Search" in release 2016 and later. This function
searches the database over all entities (Servicecall, Incident, Problem, Change, Workorder, CI). 

This function is only available when the PROLIN Power Server Connector is used and when the Search module is
active on PROLIN Power Server (which means Elastic Search needs to be installed on a  server as well) and one or
more types have been indexed, the button will be active. Please check with your administrator if the Global Search
button is not enabled.

Clicking on it will activate a text editor in which the user can type search strings. Pressing the "Find Now" button or
the F2 key on the keyboard will execute the query.

The only view that is available for Global Search is the "Global Search" view. This view cannot be changed or
modified.
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Global Search

7.4 Editing Filters

The advanced filtering of PROLIN Smart Client allows complex filters on views, columns of views and in advanced
find. Although the technology is the same, there are differences in the various filters.

· View filters are part of the view definition and can be changed in the View Options dialog. In the view filter you
can filter on any field available for the type of item the view is made for.

· View formatting conditions are part of the view definition and can be changed in the Format Rules screen of the
View Options dialog. In the Format Rule you can determine which items in the view are formatted to attract
extra attention.

· Column filters apply to the columns in a view and are edited in the Filter Editor window. In the column filter you
can only change the filter of columns already available in the view.

· Advanced find filters are found on the advanced tab of the Advanced Find dialog. Just like the view filter you
can filter on any field available for the type of item you are searching.

Although the choice of fields available for filtering is different, editing the filters works the same for all filters.

You can make very complex filters, for very specific results.  Simpler search conditions return the results fastest.
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7.4.1 Parts of the Filter

A filter consists of one or more condition groups. A condition is a statement about how a field value must contain a
certain value. A field must contain an exact value or must contain a described value. One or more conditions are
combined in a condition group. If the values of an item meet the condition of the filter, the item is shown in the
view.

Parts of the filter

The logical operators determine how the conditions are combined to find results. You can nest condition groups.
Conditions are evaluated from the deepest nested condition group to the top. First the deeper nested condition
group is evaluated, the result is then used to evaluate the next higher condition group.

7.4.2 Editing the Filter

To edit the filter in the Advanced Filter of the View Options dialog or the Filter Editor window, do the
following:

1. Click on the logical operator and choose a logical operator from the logical operator menu.

The logical operator menu

·And  to find results if all conditions in the group are true

·Or  to find results if one of the conditions in the group are true

·Not  And to find results if all the conditions in the group are false

·Not  Or to find results if all conditions in the group are false or all conditions in the group are true.

·Add Condition  to add another condition to the group.

·Add Group  to add another group within the current group.

2. Click on the bracketed field name and choose a field from the field name list.
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3. Click on the predicate and choose a predicate from the predicate menu. Different types of fields have different
sets of predicates.

Predicates for code fields     

Predicates for monetary  fields    

Predicates for string fields

·Is any of  results in true if the field equals any of the selected values.

·Is none of  results in true if the field does not equal any of the selected values.

· With hierarchical codes, Is any of  results in true if the field equals any of the
selected values or a value that is a descendent of the selected value.
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Predicates for relation fields      Predicates for date fields

·Is Blank  and Is not blank  are technically not predicates. Is blank  will return true if no value is entered in the
field; Is not blank  will return true if any value is entered in the field.

4. Depending on the field name and the predicate you chose, the values must be entered in different ways.
Click <enter a value>  and enter a value.

· Type a value or click the menu arrow to open a selection menu and select a value.

· For string and text fields, see Searching On Strings.

· For ID fields, see Searching On IDs.

· For date fields, see Searching On Date Fields.

7.4.3 Adding Groups and Conditions

To add a new condition group click on the operator and choose Add Group to insert a new condition group below
the current group.

To add a condition to a group click on the operator and choose Add Condition or click the plus button right from
the condition.

7.4.4 Searching on Strings

To search on strings and text fields, you type part of the text you are looking for. Depending on the predicate in the
filter, PROLIN Smart Client will search for the given text begin, end or anywhere in the text field.

You can also use wildcards in the search text. Two wildcards can be used, the percent (%) and the asterisk (*).
Percent and asterisk work the same, they function as placeholders of one or more characters. For example, the
search string 'PERF*op' will result in values that start with 'PERF' and that end with 'op' and that have any length of
characters in between.

7.4.5 Searching on IDs

To find items on their ID in Advanced Find in the General tab or the Advanced tab, enter one of the following in
the ID field.

· Type a single ID.
Example: 120. This example will retrieve the item with ID 120.
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· Type a range of IDs.
Example: 100-110. This example will retrieve all items with an ID in the range between 100 and 110.

· Type any combination of single IDs and ranges of IDs, separated by semi-colons..
Example: 100-110;120;130-135;203. This example will retrieve all items with an ID in the range between 100
and 110 or with the ID 120 or with an ID in the range between 130 and 135 or with ID 203.

7.4.6 Searching on Date Fields

To find items on date field values in Advanced Find in the General tab or the Advanced tab, click in the date value
field to open the date selection window. The date selection window appears above or below the field:

Create a date selection as follows:

· To select a specific date, click Absolute and select a date. Change month by clicking the triangle arrows.
Change the year by clicking on the year and then clicking the triangle arrows.

· To select a range of dates, click Absolute and click on the starting date then drag the mouse to the end date of
the range.

· To select a relative date, click Relative. When you have chosen the predicate After, On or after, Before or
On or before, then the slider will be solid. When you want a date that is equal or that is not-equal to a date in a
field, then the slider is split.

· With a solid slider, drag the slider left or right. A tool tip will show the selected value.

· With a split slider, first drag one side of the slider and then drag the other side of the slider to the right date.
While you drag each side of the slider the text in the date field is updated. Stop when the correct description
is shown. Example, "2 months ahead."

· To select a relative date range, click Relative. First drag one side of the slider and then drag the other side of
the slider to the right dates. While you drag each side of the slider, the text in the date field is updated. Stop
when the right description is shown. Example: "Between 2 weeks ago and 2 weeks ahead."

· To select another descriptive date, click Other and choose one of the options. Example: "Last week."
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7.5 Using Shortcut Keys

General Shortcut Keys

Alt + F4 Exit the application

Alt + SPACE Open the console's system menu. From the console's system menu, you can restore, move, resize,
minimize, maximize, or close the console

Navigating The Console

Alt or F10 Pressing Alt or F10 when working in the console cycles between the toolbar and the windows in the
console.

Toolbars If the toolbars are selected, labels will be shown press any of the keys as shown in the labels will
start that command.

For example, try the following sequences:

· Alt - E will exit the application.

· Alt - H - O opens the User Options dialog.

· Alt - H - N - A pins down or closes the navigator window.

In the ribbon the arrow keys allow to move from one command to the other, press Enter to activate
the command.

Windows In the windows, the DOWN ARROW or UP ARROW key makes clear which window is selected.
DOWN ARROW moves to the window to the right of the previous selected window, the UP ARROW
moves to the left of the previous selected window.

The Tab key will move selection to different parts of the window. 

In the My Task window, if the double V icon is selected then Numeric Key + will expand the
window and Numeric Key - will collapse the window. 

Navigating Trees

Numeric Key
+

Expands the current selection

Numeric Key
-

Collapses the current selection

RIGHT
ARROW

Expands the current selection if it was not already expanded, otherwise goes to the first child

LEFT ARROW Collapses the current selection if it was not already collapsed, otherwise goes to the parent.

Table View

ARROW UP Move to the item line above the currently selected item line.
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ARROW
DOWN

Move to the item line below the currently selected item line.

Enter Open the form for the currently selected item.

Chart View

Alt or F10 The sequence Alt + V + C will open up a menu with chart type. Use the arrow keys to select an
chart type, then press Enter to show the chart.

Explorer View

Tab Cycles throught the views in the explorer view. Shift + Tab cycles through the windows in the
reverse direction.

Form

Alt or F10 Cycle between toolbars and form pages.

The sequence Alt - A - C will close the form.

Tab Move to next field on page. If the last field is reached, focus moves to the first field on the page. If
the last field of the main page is reached, focus moves to the tab of the first tab page.

Shift + Tab Move to previous field on page. If first field is reached then focus is moved to last field on page. If
first field of a tab page is reached the focus moves to the tab of the tab page.

ARROW
RIGHT

If the tab page label is selected, move to next tab page.

ARROW LEFT If the tab page label is selected, move to previous tab page.
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8 Working With Items
Information in PROLIN Smart Client is held in items. There are a large number of items in PROLIN Smart Client, for
example Service Calls, Work Orders, Incidents and Changes. Each item contains information that is used in a
process. To properly support the process, the item also behaves in specific ways. For example, fields may be
required or actions are started. With the standard configuration, PROLIN Smart Client is ITIL compliant. The
configuration may be changed to (also) adhere to company processes and procedures.

You will learn how to use basic behavior shared by all items in this chapter. Some items are closely related, for
example Service Calls and Incidents. Closely related items share much of their behavior. This chapter however,
explains the behavior shared by most items.

8.1 Creating an Item

There are different ways to create an item. One approach may give you more control over the creation process
than the other. One approach may be more applicable for one situation than the other. The following is an
overview.

New

To create an item with all default settings and with a default form, do the following:

1. Navigate to the item view for which you want to make a new item.

2. In the Item group on the Home tab, click New. The new item is now shown in the default form and contains
values as defined in the default template.

The Item A ction Group

Alternatively, to create a new item with all default settings, right click in the item's view and choose New from
the pop-up menu.

NOTE : In views that can show multiple items, such as the My Tasks  view, a dialog will appear in which you must
choose a specific item to create.
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3. To apply additional values from another template, choose a template from the Apply Template menu in the
Template action group. The currently applied template is highlighted in the menu.

A pply  a template on a new  item

After you save the item, you cannot change the chosen template anymore. The next time you open the
template, the button in the Templates group will be grayed out and the button's label will show the first applied
template.

F irst template
applied

NOTE  You can create a new item with default settings and the default form from any view. In the view, select the
item you want to create from the New menu.

The New  Menu

Choose a Form to Create an Item

To create an item in the form of your choice, do the following:

1. Navigate to the item view for which you want to make a new item.
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2. Open the New menu and point to Create With.

C hoose a form to create an item

3. Choose the form you want to use to create the new item.

See also:

Set the Default Form

Copy Information to a New Item

Service Calls, Incidents, Work Orders, Changes and Problems contain similar information. The information similar in
these items can be used to create a new item. When the new item is of the same type as the item you are working
with, more information is copied than when the new item is of another type. The information copied to the new
item cannot be changed. Not all copy directions are available, the copy methods available roughly follow common
ITIL process flows.

To create an item from copied information, open the item from which you want to copy. In the copy menu, choose
the item you want to create. The following image shows the copy menu from a Service Call form.

C hoose the item to create w ith copied
information

8.2 Creating Multiple Configuration Items at
Once

The Generate CI Wizard allows you to create multiple Configuration Items at once. Some planning is useful before
you start the wizard. Make sure that you have or know the following.
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·The total number of Configuration Items to be created . The wizard will create the given number of
configuration items. Once started you cannot cancel it, if you use a number that turns out incorrect, you will loose
time with creating, deleting and re-creating configuration items.

·The template contains the right information . The template you use to create the configuration items
contains all the information that will be in the newly created configuration items. You can change the information
in the process, but the time you execute the wizard may not be the handiest time to check the template. Make
sure you use the right template and the template contains the right information before you start the CI wizard.

To start the CI Wizard, choose Generate CI Wizard from the More Tools menu in the Tools group.

Generate C I Wizard in the Tools group

1. The Generate CI Wizard opening screen appears, read and click Next.

C I Wizard opening screen

2. In the Total Numbers and Template screen, enter the number of Configuration Items you wish to make in the
How many configuration items do you want to generate? field.

Enter total number of items and template

Select the template from the template list. Some templates need information specific for use in the wizard. For
example, the location of the configuration item may have to be set each time you use the wizard. To enter this
information click Modify Fields. A form is now shown in which you can modify field values. The modified field
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values are not stored in the template and are only used for the current use of the wizard. After you modified the
needed information, click Save and Close in the Modify Fields form.

After setting the total number and template, click Next. If the template does not contain required information, a
warning is shown. Read the warning, close it and modify the fields mentioned in the warning as described
above. Alternatively you may choose another template that contains the correct information.

The mentioned fields need a v alue

3. In the Define Search Code screen, determine what the search code will look like.

When you create non-unique items, you may want to allow variation in the search code. Choose the Functional
ID of Generated CI option to create suffixes that end in the functional ID. Choose Sequence number with
length, to generate a suffix that starts at 1 for each use of the wizard. If you choose to use a sequence
number, enter the length of the sequence number in the length field. The length of the sequence number must
be enough to contain the number specified as total number in the Total numbers and template screen. The
sequence number will be filled with zeros to the left to create the length of the suffix. For example, a sequence
number with a length of three will contain "001" to "999"

Make sure the search code complies to company standards. In the Search code format field you will see an
example of the search code using your settings.

Define the search code
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4. You are now about to generate CIs, check the number of CIs that will be generated. When the number
surprises you or you feel unsure, click Back to review the settings. Click Next, the CIs will be generated. You
will not be able to stop the process. Depending on the total numbers to generate, generation of CIs may take
considerable time to complete. A progress bar will appear to show progress.

Ready  to generate C Is

5. After the CIs are generated, you may want to generate a report. Click Report to view and maybe print the
report. Click Restart the wizard to start with the first screen and generate more CIs. Click Finish to close the
wizard.

C Is generated

C I Wizard report
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8.3 Updating Multiple Items at Once

To update – edit – an item you open a form and change the field values in the form. See Opening An Item In A
Form.

When you need to update multiple items, opening forms and applying the same change in each item will be
cumbersome. PROLIN Smart Client has the Update All  function that helps you apply the same change to a selection
of items.

When you select more than one item in a view, Update All becomes available. Update All  is not available in the My
Tasks  view.

Update all is av ailable

To update selected items, do the following:

1. Select multiple items. The lower left hand corner will show the number of items selected.

Number of items in v iew  and
number of items in selection
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2. Click Update All in the Data group. Alternatively, you may right click in the selection and choose Update All in
the pop-up menu. The Update All dialog appears.

Update all dialog

3. The Update All dialog shows all fields of the item that can be changed through Update All . Modify the field
values. To clear all field value changes you made, click Clear. The values you enter in the fields replace  the
values currently stored in the selected items.

4. After you entered the needed field values, click Apply Changes. To close the dialog, click Close.

8.4 Deleting an Item

Deleting an item is a normal part of an item's life cycle. You may want to delete an item because the item is no
longer in use. However, company policies may require that you do not delete items. The Service Desk contains
archiving functions that remove items from the database according to set policies.

You can delete an item only if you are authorized to delete that type of item. If you are not allowed to delete items,
the delete function is not available to you.

An item can only be deleted if the item does not have a relation with items that depend on the item you are about
to delete. For example, many items have history lines. History lines that are not related to an item in the database
have no purpose. When an item still has reference to history lines, you cannot delete the item. When a database
contains history lines that are not related to the item they describe, the database has lost its integrity. To avoid a
database with impaired integrity, items with existing references cannot be easily deleted.

Some items, such as Person, can be blocked. Blocking is an alternative to deleting. A blocked Person cannot be
selected anymore in Lookup fields. For users of the system it seems as if a blocked item is deleted, however the
item is still in the database and existing items can still refer to blocked items.

When you want to delete an item, do the following:

1. Select the item you want to delete. You cannot delete multiple items at once.

2. Right click on the selected item and choose Delete from the popup menu.

The delete function may not be available to you.

To delete an item with references, do the following:
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1. Select the item you want to delete.

2. Click References in the Action group in the Home tab. The References dialog appears.

References in the A ctions group

3. The references dialog shows all references the current item has. Review details of the reference, select the
reference in the reference list and click Open.

References of a specific Serv ice C all

4.  When you agree that the current item and all listed related items can be deleted, click Delete. The delete
function may not be available to you.

8.5 Sending E-Mail Messages from Items

E-Mail messages can be sent from many items using a smart link. The Smart Links can be found in the Actions
group in the Home tab. The e-mail smart link must be made available by the system administrator.

The most common use of e-mail from PROLIN Smart Client is to communicate with a caller or with a Person who
has a Work Order assigned. The information contained in the created e-mail message depends on the configuration
of the system.

To send an e-mail message, do the following:

1. Select an item a view or open an item from a view.
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2. From the Links menu in Actions group, choose New Mail Message. The name of the Smart Link may vary
due to configuration differences.

Send a New  Mail Message

NOTE : The Netmeeting Smart Link works similar to sending e-mail messages. Availability depends on configuration
of the system.
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9 Advanced Topics
This chapter covers some advanced topics in order to get the maximum capabilities out of PROLIN Smart Client. 

Command Line
Automation

Allows you to execute some basic commands from the command line for integration
purposes.

Variable Expansion Allows you to specify certain constants which are replaced at runtime with real values.

View Performance
setting

Allows you to set view loading optimized for performance or for presentation.

 

9.1 Command Line Automation

The Command Line Automation (CLA) feature allows you to execute some basic commands from the command
line for integration purposes. This feature consists of a separate program named smcc.exe which exists in the
same installation folder as PROLIN Smart Client. It can be started by typing its name from a Command Prompt
window:

smcc (w ithout arguments)

You can see all its options by typing "smcc /help" (without the quotes):
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To execute automation commands the first option must always be "/a" (again without the quotes) followed by a
number of arguments which you can see by omitting them: 
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smcc (w ith automation help)

Automation Commands 

The first argument is required and specifies which automation command should be executed. Currently PROLIN
Smart Client supports one of the following:

CREATE Creates a new item based on its type or form with optional values.

OPEN Opens an existing item based on specified criteria. Depending on search results this command will either
start Advanced Find (multiple items found), open the item in a form (single item found), or ask the user
whether a new item must be created (no items found). 
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LIST Shows the Advanced Find dialog with the search results.

QUIT Terminates PROLIN Smart Client.

Automation Target

The second argument is also required and specifies a so-called automation target. The notation of this argument
should be one of the following:

TYPE=<typena
me>

Uses the default form for a type specified by <typename>. 

FORM=<formna
me>

Uses the form specified by <formname>.

If either <typename> or <formname> contains you must wrap them between double quotes.

Criteria

Any following argument (after the automation command and target) is treated as criterium and you can specify as
many as needed. You can use them as part of a query or to fill in fields with values. The notation of a criterium is
always:

<fieldname><operator>[<value>]

The <fieldname> can be either the internal (non-localized) field name or its (localized) display name. The following
operators are supported:

 = Equals

 > Greater than

 >= Greater than or equals

 < Less than

 <= Less than or equals

 != Not equals

 : Assignment

 

Note that all operators (except the assignment operator) are used for filtering purposes. The assignment operator
is used to populate fields with values. Omitting the value means an empty value. You can also use wildcards (i.e. *)
for queries. 
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Both the <fieldname> and <value> must be enclosed between double quotes when it contains spaces. For
example:

"Closure code"="Not solved"

The <value> can refer to field names as well when the automation command is started from a smart action. To
achieve this the value must be enclosed between square brackets:

"Configuration Item"=[Configuration Item]

There are also a number of special constants that can be used. These are replaced with runtime information upon
query execution or field assignment. There are some predefined constants, but you can also use system
environment variables and WMI information. For a complete list refer to Variable Expansion.

9.2 Variable Expansion

Variable Expansion allows you to specify certain constants which are replaced at runtime with real values. This
functionality can be used in filter conditions, but also as command line argument for the Command Line Automation
(CLA) feature. Besides some predefined standard constants you can also refer to system environment variables
using the the following syntax:

  %VARIABLE_NAME%

For example:

  %OS%

Standard Constants

${Process.CommandLine}

${Process.WorkingDirectory}

${Process.MemorySize}

${Machine.Name}

${Machine.CPUCount}

${Network.IPAddress}

${Network.MacAddress}

${OperatingSystem.Name}

${OperatingSystem.ServicePack}

${OperatingSystem.Version}

${OperatingSystem.SystemDirectory}

${User.Domain}

${User.Name}

${NETRuntime.Version}

${CRLF}
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WMI Constants

The WMI constants always use the following notation:

  ${wmi:<ClassName>}

The <ClassName> refers to a WMI class, for example:

   ${wmi:Win32_LogicalDisk}

Also, you can select a specific object like this:

  ${wmi:Win32_LogicalDisk[Name='D:'].Size}

For a complete list of WMI classes refer to http://msdn.microsoft.com/en-us/library/aa394084(VS.85).aspx.

9.3 View performance setting
Using the setting shown below you can improve performance of views by limiting the number of rows that is taken
into account for best fit calculation.

When best fit is being calculated for a view with a large number of rows, all those rows are taken into account
which brings down performance.

http://msdn.microsoft.com/en-us/library/aa394084(VS.85).aspx
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In the User Options window under Advanced users can influence how Smart Client behaves when loading views. 

The user can choose from two options:
1) Adjust for best performance (default)
2) Adjust for best presentation

The result of the first option is that for table views the first 1000 rows are taken into account when calculating the
best-fit widths for the columns. The second option takes all rows into account.

Note: When switching options PROLIN Smart Client needs to be restarted to activate the change.

9.4 Delay refresh after save item

This setting can be used in situations where the refresh of an item in the form after save is done before the server
side (database) rules are done. In some exceptional cases this can occur and setting this value can help solving that
synch issue.

The value can range from 0 - 5000 (ms). The value "0" means there is no delay used.

This value can be set via a startup parameter as well. See the installation manual for more information on this, and
other, startup parameters of PROLIN Smart Client.

Please always check with you administrator before setting this parameter. 
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9.5 Service call Hierarchy

This function is available in PROLIN Smart Suite 2016 R5 and later versions. 

It allows users to link service calls to service calls and thus create a Master - Subordinate structure.

Initialize Service call Hierarchy

In order to use this functionality some settings have to be set in the database. This can be done in the Admin -
Application Settings dialog.

Go to Business logic - Service call Hierarchy

If you are not connected to the correct version of Power Server (2016 R5) you will see below message and the
button will be disabled.

If you are connected to a correct version of Power Server you will see below message and the button is enabled.
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If you press the Initial Setup button you will get a dialog asking to confirm that you will be making some additions
to the database.

The changes are only for adding the Service call Hierarchy, no existing data is changed.

Service call Hierarchy settings

After the initial setup was successful you will get below dialog when going to Business logic - Service call
Hierarchy in the application settings function.
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In this dialog the Service call Hierarchy function can be enabled (by default the function is disabled).

Furthermore the following settings can be set here:

Model Type: choose between Restricted which means the structure can only go one level deep or Unrestricted
which allows for unlimited levels.

View: choose whether you want to use the default view or a specific selected view when showing subordinate
calls.

NOTE: PROLIN Smart Client needs to be restarted for all users to be able to use the Service call Hierarchy feature
when enabled (the same is the case when Service call Hierarchy is disabled).

Use Service call Hierarchy

Users can use the Service call Hierarchy function in the Subcontract calls section in a Service call form. The
Collection Editor has two new buttons: New and New with Copy.
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If you use one of these buttons to create a new service call, the active service call automatically becomes the
Master service call. The newly created service call will be the subordinate of that master service call.

The "New" button allows the user to create a new Service call, which will be added as a Subordinate to the current
Service call.

The "New with Copy" button allows the user to create a new Service call with values of fields from the Master
Service call being copied over to the new Subordinate Service call.

The fields that will be copied are defined in the Copy Fields section in the Admin Console.

When the Service call Hierarchy function is enabled there are three types of Service calls: Regular, Master and
Subordinate. When the Service call is a Master or Subordinate, this is shown in the status bar on the bottom of the
form:

When the Service call Hierarchy function is enabled, two extra buttons will be available in the ribbon of Service call
Forms.

If you are in a master service call, the Show Subordinates button is enabled: 

If you click it, it executes an Overview action that shows the direct Subordinate Service calls for this master item.

If you are in a Subordinate Service call, the Open Master button is enabled:
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Clicking this opens the Master Service call.

In a regular call (not a Master not a Subordinate Service call) both buttons are disabled.
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10 Administration Module
This chapter covers the functionality of the Administration module of PROLIN Smart Client.

10.1 Starting the Administration Module
To initiate the Administration module make sure PROLIN Smart Client is started and you are logged in.

Note: The admin functionality is not available if the admin module has not been installed or the logged in user is

not authorized under the System administrator role.

The Admin Client can be started from the Application menu. The Application menu can be found to the left of

the Home tab in the ribbon. The following image shows the Application menu.

Selecting Administration from the Application menu will display the PROLIN Admin Client main menu.
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10.2 Navigation
The main admin menu is where all the admin functions are located. See the next chapter for a map of SD admin

functions to identify where they are located in the new PROLIN Admin Client.

The navigation In PROLIN Admin Client has been improved to make it easier to find functions by providing a more

generic way to navigate between functions and the data in those functions.

The “General” item has its own layout due to the general nature of the items that can be modified under this group.

All other items have a similar method to navigate through them which are described below.
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When a function is opened a screen similar to the one below is shown.

A dministration C onsole

The screen consists of a toolbar, a Navigation Tree and a Data Window. 

The toolbar contains the following items:

Navigation buttons Buttons for “Back”, “Forward”, "Go Up" and "Refresh" view navigation.

Action buttons Possibility to create a new item or delete an item for sections where this is valid.

Search box Performs a search on the data in the data window.

The Navigation Tree shows all available administration functions.

The data window shows the data for that section. Depending on where you are you can either drill-down into the

data shown or open it for editing. For example, under Presentation – Forms you will view all available entities

(Change, Problem, etc.) in the data window. When you double click on an entity it shows all forms for that entity. If

you double click on a form it opens the data dialog.
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10.3 Mapping Service Desk functions
Some admin functions in the PROLIN Administration module are placed in a different group when compared to

Service Desk. The table below shows all currently available administration functions, where they are located in

Service Desk and where they are located in the new PROLIN Administration module.

SD Function PROLIN Administration module

Tree location Admin group Section

Analyzed data Reporting Data Analysis

Business logic – Actions – Overview actions Business logic Actions

Business logic – Actions – Smart actions Business logic Actions

Business logic – Application General Application Settings

Business logic – Scheduled Tasks Business logic Scheduled Tasks

Business logic – Database rules Business logic Rules

Business logic – UI rules Business logic Rules

Data – Copy Fields Data Copy Fields

Data - Custom Fields Data Custom Fields

Data - Calculated Fields Data Calculated Fields

Data – Custom Code Data Codes

Data – Codes Data Codes

Data – Templates Data Templates

Data - Checklist - General Checklist Data Check Lists

Data - Checklist - Service Checklist Data Check Lists

Data - Checklist - Classification Checklist Data Check Lists

Presentation – Forms Presentation Forms

Presentation – Views Presentation Views

Presentation - Search Presentation Search Policy

Security – Access – Applications Account Security Accounts

Security – Access – Role Security Roles

Security – Audit – Audit rules General Application Settings - Security - Auditing

Security – Audit – Logged on users Security Active Sessions

Security – Audit – Active Application Servers Security Active Servers

Security - Enhanced Auditing - Audit Log Security Audit Log
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Security - Enhanced Auditing - Configuration General Application Settings - Security - Auditing

Security – Prevention – Required fields Business logic Required Fields

System panel – General Settings General Application Settings

System panel – Password settings General Application Settings

System panel - Regional General Application Settings
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default     51
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my tasks     35
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refresh settings     14
scheduler     40
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table     36
tree     38

- W -
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Wildcards     183
Windows     26, 34, 52

action     30

- Y -
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